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Interview schedule

Part 1. Introduction
The following is to be explained/introduced:

e Wholam

e  Where I’m from (i.e. the University, Department etc)

e What the objectives of my research are (provide interviewees with a copy of the
research framework — title, aim and objectives)

e How this interview and the data collated will be used (i.e. helping to identify
key principles for ecosystems approach based urban land use planning — this
will inform the development of an evaluation framework that will be used to
test/evaluate the new urban planning approaches developed in my research i.e.
what are its key strengths and weaknesses)

e All names will be kept confidential but other personal data (e.g. qualifications,
professional background etc) will be used in the analysis and may be
documented in the thesis. Names will never be used though and therefore these
details will never be attributed

e Chatham House rules — no direct quotations unless authorised by the
interviewee

e Chatham House rules — no direct quotations unless authorised by the
interviewee

Part 2. Background questions

The aim of these questions is to get an idea of interviewee background and
experience. This may provide important contextual data for cross-referencing with
responses to subsequent questions.

2.1 What is your background (i.e. higher education qualifications, chartered status
etc)?

2.2 What would you say are your main areas of expertise?

2.4 What type of context would you say you are most comfortable working in (e.g.
urban, rural etc)?

2.5 Where else have you worked professionally other than Glasgow/Scotland?

Part 3. Ecosystem services concept questions

The aim of these questions is to gauge interviewee understanding and awareness of
the concept of ecosystem services and their opinion of the potential utility of urban
ecosystem services providing and/or supporting the delivery of key urban services.
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3.1 To your mind, what are the defining characteristics of the urban natural
environment?

3.2 To your mind, what are the key components of the urban natural environment?

3.3 At what scale do you think it is most useful to think about, plan for and manage
the urban natural environment (e.g. city-wide, neighbourhood, site, multiple
scales)?

3.4 To your mind, does the urban natural environment provide and/or support the
delivery of key urban services? If the answer is no, proceed to question 3.8,
otherwise proceed to question 3.5

Yes No

3.5 If the answer to 3.4 is yes — which services from the following list do you think
the urban natural environment provides? Tick all that apply

e Food (crops, livestock, fish) e Maintenance of an equable
e Fibre (timber, pulp) climate

e Energy e Flood control

e Drinking water e Erosion control

e Natural medicine e Aesthetic/inspiration

e Recreation/tourism e Spiritual/religious

e Pollution/noise control e Other

e Disease/pest control

3.6 Of the services you’ve identified, which three do you consider to be most
important?

3.7 To your mind, are the services provided by the urban natural environment
context specific and why? [question can be skipped if short of time]

3.8 Are you familiar with the term ecosystem services? If the answer is no, proceed
to part 4, otherwise proceed to question 3.9

Yes No
3.9 How would you define ecosystem services?

3.10 Is the concept of ecosystem services something that you have come across in
your professional work?

Yes No

3.11 On the scale below, how would you judge your knowledge of the ecosystem
services concept (where 1 is limited knowledge and 6 is expert)?

1 2 3 4 5 6
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3.12 On the scale below, how would you judge your use of the ecosystem services
concept, implicitly or explicitly, in your professional work (where 1 is very little
and 6 is all the time)?

1 2 3 4 5 6

3.13 To your mind, what are the most important aspects or processes governing the
health and function of the urban natural environment?

4. Land use planning concept questions

The aim of these questions is gather interviewee opinion and suggestions for where
and how it is most appropriate and useful to consider ecosystem services and
ecosystems approach principles within urban land use planning.

4.1 To your mind, what are the three most important policies or regulatory
frameworks that affect urban land use planning in Scotland?

4.2 To your mind, what are the most important tools or concepts that can help urban
planners, designers and engineers think about, plan for and manage the urban
natural environment?

4.3 Which of the following are you familiar with? Tick all that apply

Scottish Planning Policy (SPP)

Strategic Development Plans (SDP)

Local Development Plans (LDP)

Development Management

River Basin Management Plan (RBMP)

Climate Change (Scotland) Act 2009

PAN77 Designing Safer Places

PAN83 Masterplanning

PANA44 Fitting Housing Development into the Landscape

Flood Risk Management Strategies

Local Flood Risk Management Plans

PANG5 Planning and Openspace

Scottish Government Design Guidance — Green Infrastructure: Design and
Placemaking

Getting the best from our land — Scotland’s land use strategy

e Scottish Government Surface Water Management Planning (SWMP) Guidance
e Scottish Government Delivering Sustainable Flood Risk Management Guidance

4.4 To your mind, what are the five most important ‘items’ from the above list for
integrating the natural environment and ecosystem services into urban planning and

why?
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4.5 What types of urban land use are most important for providing ecosystem
services and why?

4.6 From what you know about the Local Development Plan (LDP) process, what
do you think is the most useful stage to integrate consideration of urban ecosystem
services into plan-development?

4.7 Other than LDP policy, what other key mechanisms are there for delivering
natural environment and ecosystem service enhancements through urban land use
planning/management?

5. General questions

5.1 Do you think that the urban natural environment and its role providing and/or
supporting the delivery of key urban services is adequately considered in current
urban planning practice? If the answer is yes the interview is finished — proceed to
section 6, otherwise proceed to question 5.2

Yes No

5.2 What are your top three priorities for improving urban planning practice in this
regard?

5.3 What are the three main barriers to improving urban planning practice in this
regard?

5.4 What are the three main opportunities for improving urban planning practice in
this regard?
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Data from expert interviews

Question

Interviewee 1 (I-1)

Interviewee 2 (1-2) Interviewee 3 (1-3)

Interviewee 4 (1-4) Interviewee 5 (I-5)

Background questions

2.1 What is your background
(i.e. higher education
qualifications, chartered
status etc)?

Ecology; Chartered Ecologist
(CIEEM); Chartered
Environmentalist (Society for
the Environment)

BSc Civil Engineering; MSc
Environmental Systems

Degree in landscape
architecture; Chartered member
of the Landscape Institute

Chartered Civil Engineer

Chartered landscape architect
and chartered town planner;
Honours degree in landscape
architecture; Master degree in
environmental studies; Member
of the academy of urbanism

2.2 What would you say are
your main areas of expertise?

Woodland ecology; Land use of
all kinds; Practical conservation
management (i.e. nature
reserves); Practical
management of various
ecosystems; Access

Land use planning; Ecology

Landscape architecture; Urban
design; Working at a range of
scales from detailed design and
implementation up to
masterplan and urban strategy

Management; Flood risk
management (FRM);
Contaminated land,;
Environmental management

Landscape scale urban
planning; Strategic physical
planning; Making projects
happen on the ground; People
and place — improving peoples’
lives by addressing poor
landscape quality

2.3 What is your current
role?

Woodland and land use advisor
at a government natural
heritage agency

Regional/strategic land use
planning looking specifically at
the environmental component
of this

Director of a landscape
architecture/urban design firm

Group Manager of
Environmental Services
working for a large urban local
authority

Group Manager for a large
urban local authority —
responsible for input to cross-
sector strategic plans including
land use, development and
drainage plans. Responsible for
delivering the new Local
Development Plan (LDP).
Corporate input. Statutory
planning/policy. Remit changes
a lot through involvement with
strategic projects

2.4 What type of context
would you say you are most
comfortable working in (e.g.
urban, rural etc)?

Any context really. Less
familiar with urban. Rural
certainly

Comfortable working in rural
and urban context but current
role is urban

Both. Moth commonly the
company’s work focuses on
urban areas/the urban fringe i.e.
where development pressure
and change is greatest

Current role is urban though
historically 1-4 has worked in
urban and rural contexts

Urban/peri-urban. Metropolitan

2.5 Where else have you
worked professionally other
than Glasgow/Scotland?

Philippines. North/South
England

N/A

One year in San Francisco as an
assistant landscape architect
between 1990/91. Taught at
universities in the US and
Australia (landscape
architecture and urban design):
University of Oregon and
University of South Australia in

England — London, NE and
NW. Northern Ireland.
Republic of Ireland

Always in central Scotland
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Question

Interviewee 1 (1-1)

Interviewee 4 (1-4) Interviewee 5 (1-5)

Interviewee 2 (1-2) Interviewee 3 (1-3)

Adelaide. Taught in many
Scottish universities, most
notably the University of
Strathclyde where 1-3 taught
final year urban design. Has
worked on projects around the
UK

Ecosystem services concept questions

3.1 To your mind, what are
the defining characteristics of
the urban natural
environment?

Openspace and greenspace.
Watery elements and
greenspace next to water (e.g.
floodplains). Structural
diversity. Three dimensional

element incorporating trees etc.

Brownfield habitats — not
categorised as greenspace but
can be important for
biodiversity

Degraded and heavily
managed. Heavily modified

Question not asked due to time
constraints

Question not asked due to time
constraints

Question not asked due to time
constraints

3.2 To your mind, what are
the key components of the
urban natural environment?

Structural habitat. Access and
functionality — human values
are important

River valleys. Fragmented
habitats, primarily woodland.
Less intensively managed
openspaces — grassland
meadows, some components of
more formal parks. Wouldn’t
really consider parks and
gardens/amenity greenspace as
natural environment as their
primary function does not
mimic the natural environment
i.e. their primary function is
recreation/aesthetic value

Could be a whole range of
things though scale and
significance is key. Parks and
public openspaces are key in
Glasgow. Infrastructure
corridors — roads, rail and

canals. Water network and river

corridors. Public useable space
e.g. allotments, cemeteries,
school estates. Vacant and
derelict land (VDL). Areas of
semi-natural habitat will exist
within all of the above —
especially public openspace. In
Glasgow, there is limited use of
individual smaller scale green
infrastructure (GI) elements
such as street trees — bridging
scales between land parcels and
individual Gl elements is a key
gap in Glasgow

Green infrastructure — green /
blue corridors that provide
connectivity for surface water
and biodiversity. This is split
between retaining natural
corridors (this includes canals
as a historic feature) and
providing new / engineered
corridors. Areas of limited
human activity — e.g. we try to
bring back all of our VDL into
use but it does have a value
while it is VDL (e.g. natural
succession). This also applies
to areas of natural / semi-
natural greenspace though
David commented that the flora
and fauna on these sites is
under pressure from e.g. dog
walkers

What’s outside peoples’
doorstep/window. What people
can interact with immediately
e.g. private gardens. Urban
landscapes are often not very
rich —i.e. they are bland. Some
components are richer where
development pressure is less
e.g. river valleys. Key
characteristics are complexity,
interconnectedness and tapestry

3.3 At what scale do you
think it is most useful to think
about, plan for and manage

Depends really. Has to be from
a local authority (LA) wide
scale down to site/masterplan

Depends what aspects of
ecosystem services you are
looking at e.g. ecological

Scottish Government policy on
urban planning and design
issues is good but is not

Across a range of scales.

Understanding at the catchment
scale is key — i.e. to identify

Big picture — not the red line.
Must look at the interconnected
nature — too many spaces are
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Question

Interviewee 1 (1-1)

Interviewee 4 (1-4)

Interviewee 5 (I-5)

the urban natural
environment (e.g. city-wide,
neighbourhood, site, multiple
scales)?

scale. LA-wide is important for

understanding the resource,
pinch-points and opportunities.
Upwards and downwards —
scales should inform one
another

Interviewee 2 (1-2) Interviewee 3 (1-3)

connectivity will be influenced
by patch size and small patches
will have a negligible
contribution to ecological
networks at landscape scale but
may be important locally. No
hard and fast rule.

Neighbourhood scale is useful
for identifying sites for specific
management intervention — i.e.
you wouldn’t do this level of
detailed planning at more
strategic scales. Scale depends
on what you are looking
for/what your objectives are —
all three scales are important in
this regard.

Wider scales are for the
identification of more broad-
brush interventions e.g.
Strategic Development Plan
(SDP). Planning can include
more natural management units
e.g. catchments/sub-
catchments.

influencing delivery on the
ground. Because of how
planning decisions planning are
made and how subsequent
action is delivered on the
ground, the key scale is
somewhere high enough above
on the ground (i.e. development
management/DM) but not so
high that focus, detail and
deliverability is lost. In effect
there is a gap between the good
stuff at the Scottish
Government level and the DM
level.

The IGI/masterplan scale is
useful in this regard as it offers
a chunk of City that can be
considered, planned and where
plans and designs can
reasonably influence DM.
There is a need to actually
provide good information to
DM planners — LDPs are not
detailed enough in this regard.

The big problem is that there is
a gap in the system at the IGI
scale — there isn’t the planning
‘infrastructure’ in place at
present to drive this. Planning
and design at this scale should
be formally integrated with
LDPs. Some topics also need to
be looked at and planned for at
wider scales (e.g. water
management at the catchment
scale).

intervention where the whole

can become greater than the
sum of the parts.

There is also a need to do
something constructive with
individual sites even if you
don’t know or fully understand
how it will support the bigger
picture. Often it is about
leaving space to retrofit at a
later stage.

left over after planning.

Even just beyond the red line
boundary. Also key is the need
to look up.

3.4 To your mind, does the
urban natural environment
provide and/or support the
delivery of key urban
services? If the answer is no,
proceed to question 3.8,

Yes

Yes

Yes — to qualify though, 1-3
suggested that it could but more
often than not it does not.

Yes

Yes — I-5 also commented that
there is huge potential that is
currently
underused/misunderstood e.g.
there is often too much of a
focus on individual
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Question

Interviewee 1 (1-1)

Interviewee 4 (1-4) Interviewee 5 (1-5)

otherwise proceed to question

3.5

Interviewee 2 (1-2) Interviewee 3 (1-3)

uses/services

3.5 If the answer to 3.4 is yes
—which services from the
following list do you think the
urban natural environment
provides? Tick all that apply

All

Food (crops, livestock, fish);
Fibre (timber, pulp); Energy;
Drinking water; Natural
medicine; Recreation/tourism;
Pollution/noise control;
Maintenance of an equable
climate; Flood control; Erosion
control; Aesthetic/inspiration;
Other - ecological networks and
healthier lifestyles

Food (crops, livestock, fish);
Fibre (timber, pulp); Energy;
Drinking water;
Recreation/tourism;
Pollution/noise control;
Disease/pest control;
Maintenance of an equable
climate; Flood control; Erosion
control; Aesthetic/inspiration;
Other - health / activity

In 1-3's view food and health /
activity are one and the same in
a Glasgow context

Food (crops, livestock, fish);
Fibre (timber, pulp); Energy;
Recreation/tourism;
Pollution/noise control;
Maintenance of an equable
climate; Flood control,
Aesthetic/inspiration;
Spiritual/religious; Other -
transport (e.g. water bus) and
healthy lifestyles

All

Other - cultural/different
cultural reactions to landscape
and quality of life/health

3.6 Of the services you’ve
identified, which three do you
consider to be most
important?

Recreation/tourism
Flood control

Aesthetic/inspiration and
spiritual/religious — I-1 regards
these as the same thing i.e.
sense of place

Food (crops, livestock, fish)
Recreation/tourism

Flood control

Food and health/activity
Aesthetic/inspiration
Flood control

[-3’s prioritisation choices were
driven by what the urban
natural environment can do as
well as need — given the socio-
economic context in Glasgow
there is a particularly important
case for health related services
including community growing
and other healthy lifestyle type
activities. In this regard, 1-3
suggested that health/activity
and food should be linked in an
‘ecosystem service typology’
for Glasgow — this is a socially
driven issue.

Aesthetic/inspiration
Flood control

Recreation/tourism

1. Aesthetic/inspiration
(including cultural issues as per
response to Question 3.5)

2. Flood control

3. Recreation/tourism — I-5
commented that this is a key
service though there is
currently a lack of integration
between this and other services
i.e. more multifunctional
approaches etc is key for sites,
interventions etc for the
delivery of multiple ecosystem
services

3.7 To your mind, are the
services provided by the
urban natural environment
context specific and why?

Depends on the site/area and its
history. Floodplain/flood
storage is very context specific.
Can depend on climate. Wider
catchment issues beyond LA
boundaries can be important
also. Size of greenspace (patch)

Depends on climate
(temperature, rainfall etc) and
the interaction of climate with
the physical environment (e.g.
slope, aspect, altitude etc).

Cultural factors also have a key

Socio-economic context is key.
The visual/aesthetic value of an
urban area can constrain
peoples’ lives — i.e. there can be
barriers to accessing services
outwith the City for certain
communities. In this context,

Yes — e.g. in the case of
drinking water, Hamburg gets
all of its drinking water form
groundwater below the city.

Mobility of the population has

an influence — e.qg. if people

Question not asked due to time
constraints
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Question

Interviewee 1 (1-1)

Interviewee 2 (1-2)

Interviewee 3 (1-3)

Interviewee 4 (1-4)

Interviewee 5 (I-5)

and soils will also affect service
provision.

influence e.g. how people
view/interact with the natural
environment.

many of the cultural services
jump up the pecking order.
Climate is key in relation to
flooding.

have no access to a car /
transport then this makes
recreational opportunities
within the city more important.

Population density, climate and
national / local level policies
are also key factors.

3.8 Are you familiar with the
term ecosystem services?

Yes

Yes

Yes

Yes

Yes

3.9 How would you define
ecosystem services?

The benefits that people receive
from nature.

The benefits that can be derived
for people from the natural
environment.

A landscape or natural element
that performs a particular
function but is beneficial for
other reasons supporting
societal wellbeing.

The benefit that the natural
environment provides to
humankind.

The role that the natural
environment can play in the
overall quality and health of
both people and place.

3.10 Is the concept of
ecosystem services something
that you have come across in
your professional work?

Yes

Yes

Yes

Yes

Yes

3.11 On the scale below, how
would you judge your
knowledge of the ecosystem
services concept (where 1 is
limited knowledge and 6 is
expert)?

3.12 On the scale below, how
would you judge your use of
the ecosystem services
concept, implicitly or
explicitly, in your
professional work (where 1 is
very little and 6 is all the
time)?

3

I-2 commented that use is
implicit — some
aspects/services they consider
all the time (e.g. ecological
networks, flood/water
management etc) but the
concept does not provide an
overall framing to their work.
However, the use of ecosystem
services is increasing all the
time.

3or6

For the types of work that the
practice wants to do,
consideration of ecosystem
services will be very high (e.g.
IGI type projects) though the
average across the practice’s
whole portfolio will be lower.
In essence, it depends on
specific briefs and what comes
through the door.

Some project briefs are just bad
— the projects are defined by the
knowledge and limitations of
the client (i.e. the scope of the
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Question

Interviewee 1 (1-1)

Interviewee 4 (1-4)

Interviewee 5 (I-5)

Interviewee 2 (1-2) Interviewee 3 (1-3)

brief). Ecosystem services are a
big emphasis/focus where there
is the opportunity and where
the client is receptive.

There is a massive problem
where poor briefs and lack of
planning teeth resulting in
potential wider benefits of the
scheme (e.g. in terms of
Gl/ecosystem services) just not
being considered. Ecosystem
services/Gl approaches need to
be embedded within statute.

3.13 To your mind, what are
the most important aspects or
processes governing the
health and function of the
urban natural environment?

Depends on the context — each
greenspace site will fitinin a
way. Could potentially support
all ecosystem processes.
Benefits are derived from all
processes.

Land management is key i.e.
how we manage the urban
natural environment. Also, a
lack of understanding of
ecosystem processes and
benefits influences poor
management.

The way our land
use/management system works
means that other issues take
precedence over ecosystem
services and the natural
environment e.g. the drive for
economic growth and getting
things through planning will
trump ecosystem services.

The 1GI approach helps to
show how ecosystem services
and economic growth are not
mutually exclusive but current
approaches to land
use/management planning
means that they often are.

Question not asked due to time
constraints

Question not asked due to time
constraints

Embedding natural
environment in policy therefore
people will have to think about
it. Communicating/telling the
story. Land use and flood risk
management (FRM) planning.

This is often seen as ‘tree-
hugging’ — it needs to be honed
down to practicalities and
issues that people can grasp.

Land use planning concept questions

4.1 To your mind, what are
the three most important
policies or regulatory
frameworks that affect urban

Strategic Development Plans
(SDP) and Local Development
Plans (LDP) — the Scottish

Development Plans

Development Management

I-3 doesn’t think that any of
them are having an impact.

The types of policies etc that

Strategic Development Plans
(SDP) and Local Development
Plans (LDP) — the Scottish

The statutory planning system:
the National Planning
Framework (NPF), Scottish
Planning Policy (SPP),
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Question

Interviewee 1 (1-1)

Interviewee 4 (1-4) Interviewee 5 (1-5)

land use planning in
Scotland?

Planning System in general

Scotland’s Land Use Strategy
(LUS)

River Basin Management Plans
(RBMPs)

Interviewee 2 (1-2) Interviewee 3 (1-3)

River Basin Management Plans
(RBMPS)

most influence the work that I-

3’s practice is involved are:

Strategic Development Plans
(SDPs)

Local Development Plans
(LDPs)

Flood risk management plans

Planning System in general

The Water Framework
Directive (WFD) and River
Basin Management Plans
(RBMP)

Nature Conservation (Scotland)
Act 2004

I-4 commented that the first
two have a positive impact on
land use planning.

Strategic Development Plans

(SDP) and Local Development
Plans (LDP)

I-5 also commented that A key
issue/barrier within the above is
the degree of influence it can
have on transportation planning
—i.e. there are lots of separate
regulatory powers that can
allow transport projects to
steam ahead. There is a need to
change the mind-set of road
engineers.

4.2 To your mind, what are
the most important tools or
concepts that can help urban
planners, designers and
engineers think about, plan
for and manage the urban
natural environment?

Lots of guidance out there —
some will be better than others.
Integrated Habitat Networks
(IHN)/anything that is map
based and simple — not lots of
text. SNH are developing
interactive map based tools that
are simple to dip in and out of —
doesn’t take a lot of time and
investment to understand and
can be used for specific
projects/issues.

Green infrastructure and green
network approach — seeks to
work with what is already there
in terms of the natural
environment (i.e. on greenfield
sites) or restore it to mimic
what was once there.

The network aspect of green
networks is crucial for
connectivity — including water
environment connectivity re
addressing morphology
pressures etc.

Landscape scale ecology i.e. to
facilitate planning at a scale
that reflects how the natural
environment actually works.

Catchment/sub-catchment scale
surface water management
planning i.e. to facilitate
planning at a scale that reflects
how the natural environment
actually works.

IHN modelling and the use of
GIS in general.

Taking the assumption that
high level national policy is
there and having a positive
influence and that
mapped/spatial data is there and
available as general

background stuff that should be
there, good policy and data
doesn’t necessarily mean that
things will happen.

As a concept, you need good,
skilled, multi-disciplinary
people to translate policy/data
into actual change on the
ground — key to this are urban
designers and landscape
architects as this process
requires a creative/design
element.

Complex problems require
elegant solutions that can
deliver wider multiple benefits
— there is a danger that ‘black-
box’ technical solutions can
lose the creativity and design
element — i.e. they are just
tools.

Another key input is identifying
areas of anticipated change or

Vision statements and guiding
principles as a means of driving
an agenda.

Local Development Plans
(LDP) as tools.

Integrated catchment modelling
i.e. combined natural/artificial
drainage system modelling as a
tool.

Openspace strategy as a tool.

Climate Ready Clyde as a
concept — a partnership/linked
agenda looking at a problem
with a different
angle/perspective.

Healthy sustainable me — as a
tool for developing sustainable
communities through a people
focussed perspective.

More information. Tools that
can help people to act.

Guidance and help on what
applies (e.g. policies, guidance
etc) in a specific circumstance.

CPD and professional
development e.g. for road
engineers. This is a requirement
of membership of some
institutions. For example IG1 is
being led by engineers but it
needs input from LAs (re
bottom line).

For clients too — i.e. what to
expect, what is good-practice
etc.
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Question

Interviewee 1 (1-1)

Interviewee 2 (1-2) Interviewee 3 (1-3)

issues of poor urban
condition/deprivation status etc
— consideration of these issues
in conjunction with more
regulating service issues can
add value to the approach. The
IGI five elements approach is a
good reflection of this — it
really is key to consider the
wider socio-economic
development issues as well as
regulating services.

Interviewee 4 (1-4) Interviewee 5 (1-5)

4.3 Which of the following are
you familiar with? Tick all
that apply

All — 1-1 commented that some
documents are more familiar
than others

Scottish Planning Policy (SPP);
Strategic Development Plans
(SDP); Local Development
Plans (LDP); Development
Management; River Basin
Management Plan (RBMP);
Climate Change (Scotland) Act
2009; PAN77 Designing Safer
Places; PANS83
Masterplanning; Flood Risk
Management Strategies; Local
Flood Risk Management Plans;
PANG5 Planning and
Openspace; Scottish
Government Design Guidance
— Green Infrastructure: Design
and Placemaking; Getting the
best from our land — Scotland’s
land use strategy.

I-2 commented that he has
heard of the FRM and SWM
guidance documents but has not
read them.

Scottish Planning Policy (SPP);
Strategic Development Plans
(SDP); Local Development
Plans (LDP); Development
Management; River Basin
Management Plan (RBMP);
Scottish Government Surface
Water Management Planning
(SWMP) Guidance; PAN44
Fitting Housing Development
into the Landscape; Flood Risk
Management Strategies; Local
Flood Risk Management Plans;
PANG5 Planning and
Openspace

Scottish Planning Policy (SPP);
Strategic Development Plans
(SDP); Local Development
Plans (LDP); Development
Management; River Basin
Management Plan (RBMP);
Climate Change (Scotland) Act
2009; Flood Risk Management
Strategies; Local Flood Risk
Management Plans; Scottish
Government Surface Water
Management Planning
(SWMP) Guidance; Scottish
Government Delivering
Sustainable Flood Risk
Management Guidance

All — 1-5 commented that some
documents are more familiar
than others

4.4 To your mind, what are
the five most important
‘items’ from the above list for
integrating the natural
environment and ecosystem
services into urban planning
and why?

The Land Use Strategy (LUS)
and Scottish Planning Policy
(SPP) — theoretically
everything else should hang of
these two.

River Basin Management Plans
(RBMP) — catchment scale is

Local Development Plans
(LDP) — provide a holistic view
of a sizeable unit and allow for
strategic planning over a good
time frame and for the full
array of land use
considerations.

Scottish Planning Policy (SPP)

Strategic Development Plans
(SDP)

Local Development Plans
(LDP)

Local Development Plans
(LDP)

Development Management
(DM)

Flood Risk Management
Strategies

In response to this question I-5
lumped the four planning
mechanisms together as the
‘statutory planning system’ and
the two flood risk management
mechanisms together. These
were considered to be the most
important for integrating the
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Question

Interviewee 1 (1-1)

Interviewee 4 (1-4) Interviewee 5 (1-5)

crucial. RBMPs should also
cover other issues too including
flood risk management.

Climate Change (Scotland) Act
— gives an overview of
mitigation/adaptation and
includes provision for the LUS.

GI Design and Placemaking —
catch all for others e.g. PANGS.

Interviewee 2 (1-2) Interviewee 3 (1-3)

Flood risk management
Strategies — new approach that
incorporates natural flood
management (NFM) — massive
opportunity.

River Basin Management Plans
(RBMP) — identifies where
issues are, involves multiple
partners with multiple
objectives. Measures should be
incorporated with LDPs.

PANB83 — Masterplanning
covers sites of a significant
scale such that development
can [and should] incorporate
big chunks of ecosystem
services. In effect,
masterplan/neighbourhood
scale is ideal for incorporating
ecosystem services and the 1GI
approach. Also, as a PAN there
is a strong directive that it
should be used.

Land Use Strategy (LUS) —
ecosystem services are a
founding principle, trickle
down approach — as an
overarching strategy/policy it
should be informing all of the
above.

* Development Management

Same caveat applies as per
question 3.5 — the above items
have been highlighted with
respect to how they
could/should perform as
opposed to how they are
performing currently

Local Flood Risk Management
Plans

Surface Water Management
Planning Guidance

natural environment and
ecosystem services into urban
planning

I-5 also highlighted what were
felt to have the least influence —
these were the Climate Change
(Scotland) Act 2009 and the
Land Use Strategy (LUS).
PAN44 was also felt to be less
relevant in a metropolitan
sense.

4.5 What types of urban land
use are most important for
providing ecosystem services
and why?

Case by case and depends on
scale. Depends on landform,
topography and soils. Depends
on which services and how you
value them.

Very context specific e.g. same
bit of woodland in two different
places may have different
value. Cultural services are
generally undervalued in
relation to provisioning and
regulating services — e.g.

PANG5 land use. River valleys.
Scale is important.

PANGDS is core of ecosystem
services though there are other
aspects of urban land use that
are important e.g. vacant and
derelict land (VDL) and
underused land i.e. brownfield
land that is not registered VDL.

Amenity greenspace offers

Depends on how they are
designed — in essence all urban
land uses can provide
ecosystem services.

Public openspace could do
nothing at all but it depends on
design — e.g. an urban street
could be designed to deliver a
whole range of outcomes.

In the absence of good design
however, the green land uses

Parks — aesthetic/inspiration
(i.e. good for cultural services),
arole in surface water
management, pollution/noise
control, recreation/tourism and
healthy lifestyles.

River corridors —
aesthetic/inspiration, flood
control, recreation/tourism and
healthy lifestyles.

Allotments — food growing,

All land uses should be
providing ecosystem services.

The focus is often on
residential areas though this is
not ideal.

Planning greenspace with
major development e.g. the
Southern General hospital i.e.
the need to go beyond amenity.
Greenspace.
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Question

Interviewee 1 (1-1)

converting parkland to
woodland. These conflicts
could potentially be designed
out though not everyone will
agree.

potential due to scale.

Interviewee 2 (1-2) Interviewee 3 (1-3)

will be the most important.

pollution/noise control,
recreation and healthy
lifestyles.

Interviewee 4 (1-4) Interviewee 5 (1-5)

All development should
provide ES.

Formal parks and managed
greenspace — this is currently
underperforming re ecosystem
services.

4.6 From what you know
about the Local Development
Plan (LDP) process, what do
you think is the most useful
stage to integrate
consideration of urban
ecosystem services into plan-
development?

Right at the start before the
plan is even thought about. Up-
front engagement.

Main Issues Report (MIR) or
even before.

Engagement driven with key
stakeholders/agencies and
possibly community
groups/councils and the general
public though it may become
unwieldy.

Main Issues Report (MIR).

Before i.e. the whole process
should be informed by these
issues. Area specific guidance
is also key in this regard.

Right at the start — the Main
Issues Report (MIR).

Right at the beginning and
through the Main Issues Report
(MIR) i.e. what the vision is
e.g. the GCVSDPA have just
sent out a vision questionnaire
— this would be a good
opportunity (noting however
that the Glasgow LDP vision is
defined by the SDP).

4.7 Other than LDP policy,
what other key mechanisms
are there for delivering
natural environment and
ecosystem service
enhancements through urban
land use
planning/management?

The Local Development Plan
(LDP) provides the blueprint
and is key.

Openspace strategies.

Local Biodiversity Action Plan
(LBAP).

More localised planning
frameworks.

Flood risk management
strategies and plans.

Development Management —
this is probably the weak link in
the chain at the moment i.e.
policy folk get it but this is not
driven through at planning
application/DM.

Question not asked due to time
constraints.

Metropolitan Glasgow Strategic
Drainage Partnership (MGSDP)
— the eight guiding principles
align to an ecosystems
approach, it has broader
objectives than just flood risk
management. I-4 commented
that Flood Risk Management
(Scotland) Act measures might
not necessarily be delivered
using ecosystem services
approach i.e. objectives could
be delivered solely with
traditional structural measures.

The placemaking agenda.

Market demand for an
enhanced urban landscape
(which would also deliver
enhanced ecosystem services).

Openspace strategies — i.e.
openspace strategies as per
PANGS.

Local Biodiversity Action Plan
(LBAP).

Natural Environment
Framework (Glasgow City
Council specific).

Fitting different sectors
together e.g. transport and
drainage + cycling/walking
routes etc.

General questions

5.1 Do you think that the
urban natural environment

Neither - sort of and getting

No

No

Yes

No
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Question

Interviewee 1 (1-1)

and its role providing and/or

supporting the delivery of key
urban services is adequately
considered in current urban
planning practice?

better.

Interviewee 2 (1-2) Interviewee 3 (1-3)

Interviewee 4 (1-4) Interviewee 5 (1-5)

However, I-4 commented that
the statutory planning system
has to address multiple
objectives and can’t be skewed
to focus on just ecosystem
services — ecosystem services
are currently recommended
within planning policy
explicitly and implicitly.

I-5 commented that this is a
huge challenge.

5.2 What are your top three
priorities for improving
urban planning practice in
this regard?

Development of GI concept and
awareness raising.

Clearer directives or even
statute from the Scottish
Government on the minimum
of what needs to be considered
in terms of LDP policy though
this would need to be balanced
with cost.

Improved guidance for what
statute regarding ecosystem
services means on the ground
for planners and developers —
must be simple and clear, could
involve checklists.

Awareness raising i.e. people
don’t get it yet.

Ecosystem Services/Gl as a
central pillar of urban planning
— more central role within
planning policy at various
levels.

More thorough
understanding/audit of what we
have already i.e. in terms of
ecosystem services and the
urban natural environment.

Supplementary Guidance for
the public realm — mainly to do
with the prevalence of hard
landscaping. There is scope for
the public realm to deliver a
wide range of ecosystem
services if designed well
including flood control,
noise/pollution control,
aesthetic/inspiration and
biodiversity.

Development Management
(DM) not being restricted to the
red line boundary — e.g. if
development is over a threshold
size it would have an obligation
to, say, reduce flood risk by 2%
within that catchment. 1-4 also
highlighted how such an
approach would require a more
flexible approach for section
106 agreements i.e. being able
to do intervention elsewhere.

Embedding in policy.

Facilitating understanding and
capacity to deal with policy
internally.

Increased awareness externally
e.g. developers, clients etc.

5.3 What are the three main
barriers to improving urban
planning practice in this
regard?

Resources/money — i.e. what a
developer is prepared to deliver
cost vs. benefits, keeping
shareholders happy etc.

Expediency/other priorities that
are easier for politicians to
understand.

Institutional inertia re adopting
new ideas — primarily LAs but
government agencies too.

Business as usual —e.g. to
achieve the MGSDP 50 year
vision will require a real step
change in approach. 1-4 gave
the example of the recent
public realm works on George
St that is replacing
impermeable hard standing
with the same and no provision
for storm water storage etc

The red line.

Focus on immediate sites e.g.
parks management.
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Question

Interviewee 1 (1-1)

Interviewee 2 (1-2)

Interviewee 3 (1-3)

Interviewee 4 (1-4)

Interviewee 5 (I-5)

Budget silos — the type of
public realm we (i.e. the
MGSDP) aspire to will come at
a higher management cost.
These types of approach have
wider multiple benefits but
these are not reflected in
budgets (e.g. enhanced budget
for maintenance).

Catchment Masterplanning — to
map out blue / green corridors.
I-4 commented that this is not
currently a requirement of the
Flood Risk Management
(Scotland) Act.

Moving from planning to
implementation — relative
priority of ecosystem services
vs. education vs. NHS vs.
elderly care etc.

5.4 What are the three main
opportunities for improving
urban planning practice in
this regard?

Promote and raise awareness of
the wider/multiple benefits of
Gl etc.

Thinking beyond the site e.g.
using s106 funds elsewhere,
offsetting approaches etc —
links to scale issues at Question
3.3.

More stick — i.e. adopting this
in central policy.

Knowing what the barriers are
is a good start — identifying
support to overcome these is
then the next step.

There is a need for a clear
agenda.

North Glasgow integrated
water management system
including dynamic management
with the canal (demonstration
project).

MGSDP Implementation Plan —
being able to articulate what
this will look like on the
ground.

Surface Water Management
Plans (SWMP). These are a
distinctly urban device i.e.
managing water from where it
falls to where it eventually ends
up. I-4 commented that these
are what add value across
agendas. Legislation acts to
stimulate thinking in this field.
Implementation is key.

Big opportunity in Glasgow is
the MGSDP.

Flood risk management, surface
water management and water
management generally — this is
a tangible issue that people can

grasp.

Risk — sustainable response to
corporate risk management.
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Appendix 3: A new suite of
guiding principles for ecosystems
approach based urban land use
planning
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Introduction to the principles

The table below provides a suite of guiding principles for ecosystems approach
based urban land use/management planning. The principles in the first column are
generic and taken verbatim from CBD Secretariat (2013a) i.e. these are ecosystems
approach principles as per the Convention on Biological Diversity (CBD). These
principles are introduced in the main volume of the thesis at section 3.2.4 and Table
3.8. The CBD ecosystems approach principles shown in the table below have been
categorised in line with Scottish policy on land use/management and the
ecosystems approach as per Scottish Government (2011c). This is explained further
at Table 3.8 in the main volume of the thesis.

The sub-principles in the second column have been developed through this research
on the basis of the material collated, analysed and synthesised in the evidence
assessment described in Chapters 3, 4, 5 and 6. The analysis approach used to
develop the sub-principles is described in Chapter 8 at section 8.1.1. The sub-
principles are designed primarily for use in urban land use/management planning
though some principles will be of more general relevance.

The third column provides references to indicate the provenance of the new sub-
principles within specific parts of the evidence assessment in the main volume of
the thesis or specific key references (e.g. journal articles, official reports,
government policy etc) that have played a crucial role within the evidence
assessment. The references are intended to signpost the reader to more detailed
information that can aid the interpretation and translation of the principles in
practical urban land use/management planning. In this regard, the principles are
intended to provide high level statements of good-practice as opposed to detailed
implementation guidance. For specific principles, implementation guidance has
been delivered through the tools and models developed in this research — see
Chapters 7 and 8 in the main volume of the thesis and Appendices 4, 5 and 6.
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A new suite of guiding principles for ecosystems approach based urban land use planning

Sub-principles for ecosystems approach based urban land use/management Reference(s)
approach principle
Principles relating to the management of natural systems
EsA_1: Ecosystem Spatial delineation of urban ecosystems for management purposes (e.g. on the basis of Section 3.2.1

managers should
consider the effects

similar climatic conditions, geophysical conditions, surface cover, resource management
systems) should consider how delineation can incorporate multiple ecosystems. Where

(actual or potential) of EsA_1.1 relevant, this can help to ensure that the functioning of ecosystem processes/intermediate
their activities on services (e.g. ecological interactions, nutrient cycling etc) are considered both within and
adjacent and other between ecosystems. This sub-principle is also relevant to EsA_2
ecosystems Early on in the development of urban land use/management strategies, including Local Sections 3.1.2 and 5.1.1
Development Plans (LDP), consider engaging neighbouring authorities to explore Table 3.3
EsA 1.2 transboundary ecosystem issues as well as opportunities for joint land use/management Expert interview data
= action that can help to protect and restore ecosystem structure and function. This sub- (Appendix 3 and section
principle is also relevant to EsA_2 5.1.1)
Phillips et al (2014)
Integrated land and water management planning (as part of a sustainable approach to Flood Sections 4.1 and 4.2
Risk Management (FRM) for example) should ideally be undertaken at the whole catchment | Figure 4.3
EsA 13 scale. Working at the catchment scale can require cross-boundary working with Phillips et al (2014)
= neighbouring authorities — urban planning authorities in this situation should consider how
catchment scale planning can be developed through partnership working and the use of
formalised partnership agreements
Regional scale land use/management plans are likely to incorporate multiple whole Section 6.4.1
ecosystems/landscapes/catchments. Planning at this scale therefore can ensure that the Phillips et al (2014)
EsA 1.4 | effects of land use/management change on adjacent ecosystems are considered. This could
be undertaken as part of a tiered planning system - e.g. regional scale plans establishing a
broad framework for more detailed sub-regional and local level plans
EsA_2: Conservation of Land use/management decisions should be informed by an understanding of the functioning | Section 3.1.4 pp.55
ecosystem structure and EsA 21 of the ecosystems which they affect in order to maintain the benefits of the ecosystem Table 3.5
functioning, in order to - services which they provide Scottish Government
maintain ecosystem (2011d p.4)
services, should be a ESA 22 Consider the implications of land use/management decisions across all aspects of ecosystem | Sections 3.2.1, 3.2.2, 3.2.3

priority target of the

function (ecosystem processes/intermediate services). Consider how changing one aspect

and 6.1.1
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Sub-principles for ecosystems approach based urban land use/management

CBD ecosystems
approach principle Details of sub-principle

Reference(s)

Figures 3.6 and 3.8

ecosystem approach

can bring about changes at the ecosystem level, potentially affecting the supply of ecosystem
services. This sub-principle is also relevant to EsA_9 and EsA_10

For management purposes, ecosystem processes/intermediate services should be considered
irreplaceable and un-substitutable. Urban land use/management plans should work towards

Mace et al (2011)

Sections 3.2.2, 3.2.4 and
6.2.1

EsA_2.3 | an overall objective of maintaining ecosystem health and function as well as ecosystem Figures 3.6 and 3.8
services Mace et al (2011)
Adopt the principles of landscape ecology in urban land use/management planning to Section 3.2.1
maintain and improve ecological connectivity, thereby facilitating landscape scale ecosystem | Figures 3.6 and 3.8
EsA 2.4 | processes. Ecological connectivity in this regard is essential for the maintenance and Section 5.1
enhancement of biodiversity. This sub-principle is also relevant to ESA 8 Figure 5.1
Ensure that all relevant key themes, 'big ideas' and statutory provisions within Local Section 3.1.2
Development Plan (LDP) Main Issues Reports (MIRs) consider how land use/management Table 3.3
EsA_2.5 | within the plan area can help to protect and restore ecosystem structure and function Expert interview data
(Appendix 3 and section
3.1.2)
Urban land use/management plans, including Local Development Plans (LDPs), should Section 3.2.4
EsA 2.6 integrate and manage the range of demands placed on the urban ecosystem such that it can Table 3.7
= support essential ecosystem services indefinitely
Urban land use/management plans, including Local Development Plans (LDPs), should seek | Section 4.1
to restore and enhance the urban natural environment's role supporting natural drainage Tables 4.1 and 4.6
EsA 2.7 | Processes - interception, evapotranspiration, infiltration, attenuation and conveyance. This
= can support the more natural functioning of the hydrological cycle in modified urban
catchments as well as enhancing key water management related ecosystem services
EsA_3: Ecosystems must Environmental limits data (including spatially explicit data) should be used to target Section 3.2.1
be managed within the restorative land use/management action - i.e. where specific intervention to enhance Figures 3.6 and 3.7
limits of their functioning | ESA_3.1 | ecosystem services or restore degraded aspects of ecosystem function should take place.

This is in addition to its use defining constraints for land use/management - i.e.
environmentally sensitive areas where development should not take place
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CBD ecosystems
approach principle

EsA_4: The ecosystem
approach should be
undertaken at the
appropriate spatial and
temporal scales

Sub-principles for ecosystems approach based urban land use/management

Details of sub-principle

EsA_3.2

EsA 3.3

EsA_3.4

EsA_4.1

EsA_4.2

EsA_4.3

EsA_4.4

Consider how threshold (biophysical) and non-threshold (social preference) approaches can
be used to define environmental limits for land use/management planning. The choice of
approach should be informed by data availability, planning context and scale

Use policy and management interventions to account for data gaps and uncertainty in
relation to ecosystem function and the definition of environmental limits e.g. the use of
‘buffer zones' around threshold or non-threshold environmental limits

Consider how the use of different types of environmental limit indicator (pressure, state and
ecosystem service indicators) can help to address data gaps and uncertainty in relation to
ecosystem function and the definition of environmental limits

It may be useful to disaggregate the urban natural environment into ‘green’ and 'natural
environment' type land parcels. For planning and management purposes, these can then be
construed as the spatial 'building blocks' of urban ecosystems. In Scotland, Planning Advice
Note (PAN) 65 provides a useful typology of openspace for this purpose

Ensure that the approach adopted in the spatial delineation and disaggregation of the urban
natural environment sufficiently reflects the heterogeneity of the urban landscape

Urban land use/management planning for the restoration of ecosystem structure and function
and enhancement of ecosystem services can be undertaken at a range of scales: 1) landscape
or whole ecosystem scale - key management units could include whole catchments, whole
landscapes, river corridors and floodplains, large parks and gardens of city-wide importance,
urban forest parks, large areas of natural/semi-natural habitat, large areas of amenity
greenspace (e.g. associated with a large housing scheme or business park), regional SuDS
and associated habitats, strategic areas of public realm/municipal plazas; 2) land parcel
scale - discrete areas of amenity greenspace, pocket parks, small patches of natural/semi-
natural habitat, collective and/or private gardens, allotments and burial grounds/cemeteries;
and 3) specific green infrastructure intervention within land parcels - source control
SuDS measures (e.g. green roofs, permeable surfaces, rain gardens), site control SuDS (e.g.
detention basins), street trees, small ponds, footpaths, signage, street furniture etc

Where possible (e.g. within the framework of relevant legislation and regulation), urban land
use/management strategies, including Local Development Plans (LDPs), should set long
term objectives for land use/management (including ecosystem and natural environment

Reference(s)

Section 3.2.1 and 6.2.1
Figures 3.6 and 3.7

Section 3.2.1
Figures 3.6 and 3.7

Section 3.2.1
Figures 3.6 and 3.7

Sections 3.1.3 and 3.2.1
Figure 3.3

Table 3.4

AECOM (2011)
Scottish Government
(2008)

Section 6.1.2

Phillips et al (2014)
Section 3.1.3

Expert interview data
(Appendix 3)

Figures 3.4 and 3.5
Tables 3.4 and 4.7

Sections 1.5, 3.1 and 3.1.1
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CBD ecosystems Sub-principles for ecosystems approach based urban land use/management
approach principle Details of sub-principle

EsA_5: Recognising the
varying temporal scales

and lag-effects that EsA 5.1

characterise ecosystem

processes, objectives for

ecosystem management

should be set for the long

term
EsA 5.2
EsA 5.3

EsA_6: Management
must recognise the
change is inevitable

management). This sub-principle is also relevant to ESA 5

Consideration of ecosystem services should be integrated with strategic plans that have
forward looking visions and set long term objectives. In terms of the statutory planning
system in Scotland this could include the National Planning Framework (NPF), Strategic
Development Plans (SDPs) and some Local Development Plans (LDPs). This sub-principle
is also relevant to EsA_4

Consider how an analysis of ecosystem state indicators and/or ecosystem service indicators
can be used to identify key trends and the driving forces behind these trends. This can
provide a useful means of setting long term objectives for ecosystem management - e.g.
trends help to indicate potential future problems which may need to be addressed by setting
management objectives and delivering interventions in the short term. This sub-principle is
also relevant to EsA 4

Use openspace audits and strategies to establish robust baselines and set long term objectives
for the management of the urban natural environment and associated ecosystem services. In
Scotland, this type of approach is set out in Planning Advice Note (PAN) 65

No sub-principles identified

Principles relating to ecosystem services

EsA_7: Recognising
potential gains from

management, there is EsA 7.1
usually a need to -
understand and manage
the ecosystem in an
economic context. An

Y| EsA 72

such ecosystem

Ecosystem service values (monetary or non-monetary) can help to cast a different light on
complex decisions, especially where there is conflict between economic and environmental
objectives. Ecosystem service assessments in this regard can help to demonstrate the full
value of the natural environment

Economic prosperity and wellbeing is dependent on ecosystems providing flows of goods
and services. Where appropriate, monetary values for ecosystem services should be

Reference(s)

Section 3.1.1 and 6.3.1
Tables 3.1 and 3.2

Section 6.2.1
Figures 6.5 and 6.6

Section 3.1.3

Figure 3.3

Table 3.4

AECOM (2011)
Scottish Government
(2008)

Section 3.2.3
Table 3.6

Sections 3.1.3, 3.2.1 and
3.23
AECOM (2011)
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approach principle
management programme
should: a) reduce those
market distortions that
adversely affect
biological diversity; b)
align incentives to
promote biodiversity
conservation and
sustainable use; and c)
internalise costs and
benefits in the given
ecosystem to the extent
feasible

EsA_8: The ecosystem
approach should seek the
appropriate balance
between, and integration
of, conservation and use
of biological diversity

EsA_7.3

EsA 8.1

EsA 8.2

EsA 8.3

EsA_8.4

Sub-principles for ecosystems approach based urban land use/management

Details of sub-principle

considered in decision-making, including urban land use/management decision-making e.g.
where proposed land use change may affect the provision of land based ecosystem services

Use statutory policy within Local Development Plans (LDPs), in conjunction with
Development Management and Enforcement, as key regulatory drivers to protect and
enhance land based ecosystem services. This sub-principle may be particularly important in
the absence of economic assessments of ecosystem services i.e. to provide proxy protection
for biodiversity and ecosystem services where there is no data available to support
consideration of the monetary value of ecosystem services in economic analyses

Opportunities for urban land use/management to deliver multiple benefits should be
encouraged, within the constraints of defined biodiversity objectives and environmental
limits

Ensure that biodiversity is protected and enhanced as an essential factor underpinning
ecosystem function and the supply of ecosystem services. Land use/management
stakeholders should adhere to this principle even in the absence of perfect data on the role of
biodiversity in ecosystem function and ecosystem services

Within the constraints of defined biodiversity objectives and environmental limits, final
ecosystem services can be managed, manipulated and engineered to produce the ecosystem
goods that are required given the specific urban context. This sub-principle is also relevant
to EsA_9

The natural environment in northern European urban centres potentially has the ability to
supply all ecosystem services identified within the UKNEA typology, to varying degrees.
Urban land use/management strategies, including Local Development Plans (LDPSs), should

Reference(s)

Scottish Government
(2008)
EC (2011b)

Sections 3.1.1, 3.1.3 and
6.3.1

Sections 3.1.3 and 3.1.4
Table 3.5

Scottish Government
(2011d p.4)

Section 3.2.1
Figures 3.6 and 3.8

Section 3.2.2
Figures 3.6, 3.8 and 3.10

Section 3.2.2
Expert interview data
(Appendix 3 and section
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CBD ecosystems Sub-principles for ecosystems approach based urban land use/management Reference(s)
approach principle Details of sub-principle
consider how the urban land resource and specific green infrastructure interventions (e.g. 3.2.2)

SuDS, access networks, street trees) can best be managed to deliver the full range of
ecosystem services that may be required, given the specific urban context

Within the constraints of defined biodiversity objectives and environmental limits, land

use/management decisions should be informed by an understanding of the opportunities and

threats brought about by the changing climate. Greenhouse gas emissions associated with
land use should be reduced and land should contribute to delivering climate change
adaptation and mitigation objectives

Principles relating to involving people
Ecosystems (including urban ecosystems) can be managed for specific objectives, especially | Section 3.2.2

EsA _9: The objectives of
management of land,
water and living
resources are a matter of
societal choices

EsA_10: Management
should be decentralised
to the lowest appropriate
level

by manipulating final ecosystem services to target the provision of specific ecosystem
goods. Management objectives in this regard should be a matter of societal choice and the
public and affected communities should have the opportunity to influence land
use/management decisions that may impact ecosystems and ecosystem services (though
there opportunities for the public to influence private land use/management objectives may
be limited). This sub-principle is also relevant to ESA_8 and EsA_12

Cultural ecosystem services (e.g. aesthetic, inspiration, recreation, tourism) can be
particularly important in urban areas as the value of these services is influenced by factors
relating to population size and accessibility (i.e. urban areas are home to large numbers of
people that need ready access to cultural services such as outdoor recreation). These factors
can increase the importance/value of cultural ecosystem services in urban areas. The same
principle applies to hazard regulation services as the significance of natural hazard risks is
influenced by the value and vulnerability of the receptors (e.g. people and livelihoods) that
are exposed to the risks

Ensure effective decentralisation of ecosystem management within the Scottish Planning
System’s hierarchy of Development Plans - from the National Planning Framework (NPF)
down to Local Development Plans (LDPs). This sub-principle is also relevant to EsA_4
Ensure effective decentralisation of ecosystem management within the remit of individual
local planning authorities - from the Local Development Plan (LDP) through Local

Figures 3.8 and 3.9

Section 3.1.4

Table 3.5

Scottish Government
(2011d p.4)

Figure 3.8 and 3.10
Phillips et al (2014)

Sections 3.2.2 and 4.1
Expert interview data
(Appendix 3 and section
3.2.2)

Figures 3.9, 3.11, 4.1 and
4.2

Section 3.1.1
Tables 3.1 and 3.2

Section 3.1.2
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Sub-principles for ecosystems approach based urban land use/management Reference(s)
approach principle
Development Frameworks (LDFs), development briefs and masterplans to community level
land use/management initiatives such as community growing projects and community
greenspace management etc. This sub-principle is also relevant to EsA_4
EsA_11: The ecosystem Effective use of ecosystem services data at the science-policy interface to help translate the Section 3.2.2

approach should consider
all forms of relevant
information, including
scientific and indigenous
and local knowledge,
innovations and practices

EsA_12: The ecosystem
approach should involve
all relevant sectors of
society and scientific
disciplines

EsA 11.1

EsA 11.2

EsA 12.1

EsA_12.2

EsA_12.3

EsA_12.4

EsA_12.5

link between the natural environment/ecological processes and human wellbeing in a manner
that is understandable and useful for policy-makers. This sub-principle is also relevant to
EsA 12

Open up specific steps (e.g. setting model parameters and defining assumptions) in the use
of technical methodologies for the ecosystems approach to key stakeholders, the public and
affected communities to ensure that all forms of relevant information including
scientific/local knowledge, practice and innovation can be incorporated. This sub-principle
is also relevant to EsA 12

During debates and decisions about land use/management decision-making, use a broad
definition of stakeholders (including the public and affected communities) to ensure that all
relevant sectors of society and scientific disciplines are involved. This sub-principle is also
relevant to EsA_11

During debates and decisions about land use/management decision-making, especially with
the public and affected communities, frame the natural environment in terms of
‘uses/benefits' as opposed to 'things' to help non-technical stakeholders communicate
perceptions and uses of the natural environment on their terms. This sort of information can
also help decision-makers to understand the full ‘'value' of the natural environment (over and
above market values). This sub-principle is also relevant to EsA_7

During debates and decisions about land use/management decision-making, especially with
policy-makers, use ecosystem services to draw attention to the integrated nature of the
natural environment and the need for holistic management that moves away from silo or
topic based approaches. This sub-principle is also relevant to EsA_11

Use ecosystem service maps and other visual tools to communicate the human wellbeing
benefits provided by existing and/or potential future land use scenarios to stakeholders, the
public and affected communities, as a useful means of engaging people in urban land
use/management decision-making. This sub-principle is also relevant to EsA_9 and

EsA 11

At the Main Issues Report (MIR) stage of the Local Development Plan (LDP) process,

Sections 6.1.1 and 6.2.1

Section 6.2.2

Sections 3.1.1 and 3.2.3
Table 3.6

Sections 3.2.2 and 3.2.3
Figures 1.4, 3.6 and 3.8
Table 3.6

Section 6.1.2
Figure 6.2
Phillips et al (2014)

Section 3.1.2
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Reference(s)

CBD ecosystems Sub-principles for ecosystems approach based urban land use/management |
approach principle Details of sub-principle |

engage stakeholders with relevant ecosystem, conservation and landscape planning and Expert interview data
management skills to ensure that all relevant 'big ideas' and statutory provisions within MIRs | (Appendix 3 and section
are informed by a detailed understanding of ecosystem structure and function issues 3.1.2)
Table 3.3
Engage with stakeholders, the public and affected communities to validate ecosystem service | Section 6.1.2
EsA _12.6 | typologies and assessments developed as part of land use/management planning. This sub- Figure 6.2
principle is also relevant to EsA_11

359



Land use planning in urban areas — towards an ecosystems approach
Peter M. Phillips, Department of Civil and Environmental Engineering, University of Strathclyde

Appendix 4: Guidance for
Interpreting and acting on flood
control model outputs In the
development of integrated urban
land use/management strategies
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Introduction to the flood control model guidance

The tables below provide guidance to support the consideration of flood storage
ecosystem services in urban land use/management planning. The guidance in the
first table is also applicable to runoff reduction ecosystem services (see Appendix
5). The guidance has been developed through this research on the basis of the
material collated, analysed and synthesised in the evidence assessment described in
Chapters 3, 4, 5 and 6. The analysis approach used in the development of the
guidance is described at section 8.1.1 in the main volume of the thesis.

The tables include references to indicate the provenance of the guidance notes
within specific parts of the evidence assessment in the main volume of the thesis or
specific key references (e.g. journal articles, official reports, government policy etc)
that have played a crucial role within the evidence assessment. The references are
intended to signpost the reader to more detailed information that can support
consideration of the guidance in practical urban land use/management planning.

The first table provides overarching guidance for the consideration of flood
storage and runoff reduction services in urban land use/management planning. In
essence, these are key principles that can help stakeholders integrate consideration
of flood storage and runoff reduction ecosystem services within urban land
use/management plans. This is in addition to the general ecosystems approach
principles described at Appendix 3. Further information on the utility of the
overarching guidance supporting urban land use/management planning, including
worked examples, is provided at sections 8.2 and 8.3 in the main volume of the
thesis. The overarching guidance notes are grouped into the following categories:

1. Approaches and concepts;

2. Tools, policy and regulation;
3. Resilience and flexibility; and
4. Planning and intervention.

The second table provides specific technical guidance to help practitioners
interpret and act on flood control model outputs in the development of integrated
urban land use/management strategies. In essence, these are practical
recommendations describing how flood storage ecosystem services can be
enhanced, at sites and locations identified through the flood control model, through
targeted land use/management intervention. Further information on the utility of the
technical guidance supporting urban land use/management planning, including
worked examples, is provided at sections 8.2 and 8.3 in the main volume of the
thesis.

The overarching guidance notes are distinguished by a number suffix e.g.
Hydro/Flood 1.

The technical guidance notes are distinguished by a letter suffix e.g. Flood_A.
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Overarching guidance for the consideration of flood storage and runoff reduction ecosystem services in urban land
use/management planning

Ref.

Overarching Guidance Category No.1: Approaches and Concepts

Hydro/Flood_1

Hydro/Flood_2

Hydro/Flood_3

Hydro/Flood_4

Urban landscapes can provide space to store water and slow down the progress of floods. These services can be
enhanced through appropriate land use/management intervention that acts to reduce runoff at source (runoff
volume reduction) and/or provides increased flood storage (attenuation of peak flows). Designed effectively,
these types of intervention can help to reduce flood risk by reducing the likelihood of flooding, mitigating the
consequences/impacts of flooding or both. A catchment based approach to Flood Risk Management (FRM) in
this regard should consider the use of Natural Flood Management (NFM) measures in the channel, floodplain
and wider catchment

To deliver an overall reduction in flood risk, catchment based Flood Risk Management (FRM) is likely to
require a combination of natural and more traditionally engineered structural measures, in conjunction with
non-structural measures such as policy (e.g. planning policy as part of LDPs), advice and flood warnings

As a general principle for the purposes of strategic urban land use/management planning; land in the wider
catchment, river channels, floodplains etc that exhibit a greater degree of hydraulic 'roughness' can be
considered to provide greater flood storage/runoff reduction benefits. However land use/management change
that alters the hydraulic properties of land must be undertaken in a planned manner to ensure that change doesn't
exacerbate flood risk (e.g. by synchronising peak flow discharge from tributaries or causing the 'backing-up' of
flood waters where it is unsafe to do so)

Urban land use/management strategies, including Local Development Plans (LDPs), should seek to address the
complex flooding problems that can arise in urban catchments due to the interaction of different sources of
flooding, especially fluvial, pluvial and sewer flooding. As a general principle, urban land use/management
practice should help to keep surface water out of the sewer system through the use of specific green
infrastructure intervention (e.g. source control SuDS) and the enhancement and restoration of natural drainage
processes Via sustainable land use/management practices

Overarching guidance Reference(s)

Sections 4.2 and 4.7

Figure 4.3

Tables 4.2 and 4.8

Scottish Government (2011a)

Sections 4.2 and 4.7
Table 4.3
Scottish Government (2011a)

Section 4.4

Section 4.7.1

Figure 4.14

Tables 4.1 and 4.6

Scottish Government (2013a)
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Ref.

Hydro/Flood_5

An additional key objective for the planning and design of urban land use/management and green infrastructure

for the provision of runoff reduction ecosystem services (especially in the wider catchment away from river
corridors) should be to reduce pressure on sewer systems, by providing storm water attenuation

Overarching Guidance Category No.2: Tools, Policy and Regulation

Hydro/Flood_6

Hydro/Flood_7

Use Strategic Flood Risk Assessment (SFRA) in conjunction with the statutory planning system (including
Local Development Plan (LDP) policy and supplementary guidance, Development Management and
Enforcement) to guide new development away from areas where flooding is likely to occur and to protect,
enhance and restore existing land use and green infrastructure that provides flood storage and runoff reduction
ecosystem services (e.g. stretches of unmodified floodplain, other significant areas of ‘green’ and 'natural
environment' type urban land use). The restorative function is particularly important in highly modified urban
catchments to help reverse the effects of historic development pressure e.g. waterbody modification, removal of
vegetation and building over of greenspace

Consider how the statutory planning system can be used to provide new areas of 'green' and 'natural
environment' type urban land use (i.e. appropriately sited and designed multifunctional openspace as per
PANG5) and green infrastructure for the provision of runoff reduction and flood storage ecosystem services
(e.g. through planning conditions, section 106 agreements etc)

Overarching Guidance Category No.3: Resilience and Flexibility

Hydro/Flood_8

Flood Risk Management (FRM) actions should be flexible and resilient in the face of climate change. Natural
Flood Management (NFM) based structural measures (e.g. land use/management and green infrastructure) are
potentially more flexible than traditionally engineered structural measures (e.g. embankments and culverts)
which generally have a finite design capacity that can be costly or impractical to modify (e.g. in the face of
more frequent extreme rainfall events and associated higher flows)

Overarching guidance Reference(s

Section 4.2
Table 4.2
Scottish Government (2013a)

Sections 4.3, 4.2, 4.5.1 and
4.7.1

Figure 4.14

Scottish Government (2011a)

Section 4.2
Table 4.2

Section 4.2
Table 4.2
Scottish Government (2011a)
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Ref.

Hydro/Flood_9

Hydro/Flood_10

Overarching guidance Reference(s

Use hydrological and hydraulic modelling to explore the implications of a range of strategic options for
reducing overall flood risk. Modelling should consider rainfall event scenarios flows associated for a range of
different return periods, including for more extreme events (e.g. 1 in 200 year + climate change event), to
explore the efficacy of a range of different strategic options for Flood Risk Management (FRM). Where
possible (e.g. given constraints from other land uses etc), modelling should consider how land use/management
and green infrastructure based FRM strategies can be used to deliver a substantial reduction in flood risk, in
conjunction with wider multiple benefits (e.g. consolidation of existing habitat, enhancement of ecological
networks, enhanced amenity etc)

Urban land use/management planning for the restoration of ecosystem structure and function (e.g. hydrological
cycle function) and enhancement of ecosystem services (e.g. runoff reduction) should be undertaken at a range
of scales including at the landscape or whole ecosystem scale

Overarching Guidance Category No.4: Planning and intervention

Hydro/Flood_11

Hydro/Flood_12

The timing and magnitude of river runoff is dictated by natural drainage processes - interception and depression
storage, evapotranspiration, infiltration, attenuation and conveyance. Urban land use/management strategies,
including Local Development Plans (LDPs), should work to protect, enhance and restore these processes to
support the delivery of sustainable Flood Risk Management (FRM) and water management more generally.
Where appropriate (i.e. given existing constraints such as landscape and biodiversity designations), urban land
managers should seek to enhance the natural drainage processes supported by all existing 'green’ and 'natural
environment' type land uses in the urban area through targeted management intervention. In Scotland, this could
be undertaken with reference to openspace audits produced as per the requirements of Planning Advice Note
(PAN) 65. Equally, the design and management of new areas of openspace should be informed by simple
hydraulic criteria to ensure that they contribute to hydrological improvements at the catchment scale

Land use/management that enhances attenuation capacity will enhance interception capacity and vice versa as
both processes are influenced by the hydraulic roughness of the land. As a general principle, ‘green’ and 'natural
environment' type urban land uses with denser, taller, more structurally diverse vegetation will be hydraulically
rougher and have more porous, open structured soils. These properties are beneficial for sustainable Flood Risk
Management (FRM) in urban areas by helping to reduce runoff at source as well as attenuating and delaying
peak flows

Section 4.3
Table 4.4

Sections 3.1.3 and 5.1.1
Expert interview data
(Appendix 3 and section
3.1.3)

Figures 3.4 and 3.5
Tables 3.4 and 4.7

Sections 4.7.1 and 4.7.2
Figure 4.14

Tables 4.1, 4.6 and 4.7
AECOM (2011)

Scottish Government (2008)
Scottish Government (2011a)

Sections 4.7.1 and 4.7.2
Tables 4.6 and 4.7

Figure 4.14

AECOM (2011)

Scottish Government (2008)
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Ref.

Hydro/Flood_13

Overarching guidance Reference(s

The use of SuDS should be considered even when it is not possible for treated runoff to be discharged to a
waterbody (e.g. due to topographical constraints). SUDS use in this regard can provide storm water storage and
reduce pressure on sewer systems, till such time that peak discharge associated with the rainfall event has
passed. This is in addition to the wider multiple benefits that SuDS can provide in terms of biodiversity and
amenity

Section 4.7.3
Figures 4.16 and 4.17
Table 4.8

Technical guidance for interpreting and acting on flood control model outputs in the development of integrated urban land
use/management strategies

Technical guidance Reference(s

Ref.

Flood A

Flood_B

Identify possible synergies and areas of overlap between LDP related land use/management proposals (as
identified through the modelling) and objectives, policies, actions etc from related land use delivery
mechanisms, especially: 1) Scottish Planning Policy (SPP); 2) Strategic Development Plans; 3) relevant
Development Management decisions; 4) River Basin Management Plans (RBMPs); 5) Flood Risk Management
Strategies; and 6) Scotland's Land Use Strategy. Where relevant, consider how these opportunities can be
developed through partnership working and the use of formalised partnership agreements

The hydraulic properties of river channels can be manipulated to increase their roughness, increase turbulence

and decrease flow velocities. This can help to delay the passage of flood water downstream and promote out of

bank flows, helping to connect watercourses to their floodplains and enhance floodplain storage. Consider how

the hydraulic properties of river channels at sites identified through the flood control model can be enhanced for

Flood Risk Management (FRM) by:

a) Increasing the occurrence of irregularities within the channel

b) Restoring the channel to a more natural alignment reflecting the geomorphology of the catchment or
specific stretch at hand

c) Restoring the channel cross-section to a more natural shape reflecting the geomorphology of the catchment
or specific stretch at hand

d) Restoring the river bed and banks e.g. by reintroducing native vegetation and eradicating invasive non-
native vegetation

Expert interview data
(Appendix 3 and section
3.1.1)

Figure 3.1

Phillips et al (2014)

Sections 2.5.3and 4.4
RRC (2002)

Nisbet et al (2008)
Nisbet et al (2011a)

365



Land use planning in urban areas — towards an ecosystems approach
Peter M. Phillips, Department of Civil and Environmental Engineering, University of Strathclyde

Ref.

Flood C

Flood_D

Technical guidance Reference(s

The hydraulic properties of floodplains can be manipulated to increase their roughness, thereby increasing
turbulence/flow disruption and decreasing flow velocities. This can enhance floodplain storage and help to
delay the passage of flood waters downstream. Some types of floodplain measure (e.g. floodplain woodland)
may also help to reduce runoff volumes (e.g. by increasing the infiltration capacity of floodplain soils).
Consider how the hydraulic properties of the floodplain at sites identified through the flood control model can
be enhanced for Flood Risk Management (FRM) by:

a)
b)

Management intervention that alters soil properties thereby increasing infiltration capacity
Increasing surface irregularities to disrupt flood flows and increase turbulence

c) Altering the nature of floodplain vegetation to increase roughness, disrupt flows and increase turbulence

Note: Measures (b) and (c) can help to increase flood depth and extent (where safe to do so) contributing to
increased flood storage

Vegetation type can influence the hydraulic properties of floodplain and riparian land, either promoting out of

bank flows and flood storage or acting as a barrier and rushing flood flows downstream. Consider how
floodplain and riparian vegetation at sites identified through the flood control model can be designed and
managed for the provision of flood storage ecosystem services by:

a)
b)

c)

d)

Managing vegetation density to ensure that riparian vegetation does not pose a barrier to out of bank flows
Managing vegetation density to maintain flow routing between the channel and the floodplain whilst also
increasing turbulence/flow disruption to the extent that flood storage is enhanced

Designing any new planting and/or restocking to ensure that the mix of tree, shrub and grass/herb species
provide the required degree of structural diversity and stiffness to maintain flow routing whilst also
increasing turbulence/flow disruption and flood storage

Sensitive introduction and management of large woody debris (LWD) dams where appropriate and safe to
do so

Section 4.4

RRC (2002)

Nisbet and Thomas (2008)
Nisbet et al (2011a)

Section 4.4

Figures 4.6 and 4.9
Tabacchi et al (2000)
Nisbet and Thomas (2008)
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Ref. Technical guidance

Well-designed river restoration projects should provide a range of multiple benefits. Consider how potential

river restoration measures at sites identified through the flood control model can be designed to deliver a range

of multiple benefits including:

a) Addressing water environment issues (morphology pressures)

b) Restoring a more natural morphology (e.g. reinstating meanders, natural channel cross-section etc) and
flow regime (especially peak flow response times) to modified watercourses

c) Helping to increase capacity in the natural drainage network

d) Providing enhanced flood storage where appropriate and safe to do so (by reconnecting the watercourse
with its floodplain)

e) Consolidating existing aquatic, riparian and floodplain habitats

f)  Enhancing habitat networks within the river corridor and improving structural and functional connectivity

g) Providing a range of amenity benefits to local communities and other users of the water environment

Sections 4.5.2 and 4.5.3
Figures 4.7 and 4.8
RRC (2002)

Flood E

The width of woodland planting across the floodplain can impact the flood storage effect of the woodland.

As a general rule, the flood storage effect of floodplain woodland will be greater, the greater the width of

planting used. The flood storage efficacy of floodplain woodland will also be influenced by floodplain

topography, specifically the effect will be less where the floodplain is steeper. In addition to these general

principles, potential floodplain woodland measures at sites identified through the flood control model should

consider the following design principles:

Flood_F a) The impact of woodland planting delaying and/or reducing downstream peak flows decreases as floodplain

steepness increases. The steeper the floodplain the lesser the effect

b) Planting will be most effective at enhancing flood storage when located within the lower lying, wettest part
of the floodplain

¢) Relic side channels can divert flood flows back into the main channel, potentially negating the flood
storage benefit provided by the planting — detailed topographical data should be studied to identify relic
side channels in the floodplain which can be factored into woodland design e.g. in terms of planting width

Section 4.6
Nisbet and Thomas (2008)

The length of woodland planting along the floodplain can impact the flood storage effect of the woodland.

As a general rule, the flood storage effect of floodplain woodland will be greater, the greater the length of Section 4.6

planting used. Potential floodplain woodland planting measures at sites identified through the flood control Nisbet and Thomas (2008)
model should cover as great a length of the floodplain as possible, given constraints posed by other land uses

Flood G

367



Land use planning in urban areas — towards an ecosystems approach
Peter M. Phillips, Department of Civil and Environmental Engineering, University of Strathclyde

Ref.

Flood H

Flood_I

Technical guidance Reference(s

As a general rule, the flood storage effect of floodplain woodland planting will be greater, the greater the area
of planting that is used. In addition however, targeted planting of discrete woodland blocks in the floodplain
can achieve a similar overall flood storage effect with less land take. This approach can be particularly useful
helping to desynchronise flows from contributing tributaries. Consider how floodplain woodland planting

measures at sites identified through the flood control model can be targeted through the use of discrete Section 4.6
woodland blocks. Particular woodland design issues to consider include: Jacobs Babtie (2006)
a) The flood storage effect of individual woodland blocks will be influenced by site specific issues — this is Nisbet and Thomas (2008)

especially true of topography (i.e. the steepness of the floodplain cross-section) and the presence of relic
side channels

b) The siting of woodland blocks should be designed around topographical constraints. Key topographical
constraints should be mapped and planting scenarios designed around these

The choice of tree species used in floodplain woodland planting will have a significant impact on the hydraulic

properties of the floodplain and therefore the flood storage effect of the planting. The following technical

guidance should be considered in the design of floodplain woodland planting measures at sites identified

through the flood control model:

a) Ensure that the species or mix of species used is appropriate for the site conditions. Given that planting is to
take place on the floodplain, the water table is likely to be high and the soil frequently waterlogged. The
species used must therefore be appropriate for these conditions (e.g. shallow rooting) or a suitable

silvicultural treatment used (e.g. mounding — see below also) Sgctlon 4.6
. : . A . Figures 4.6 and 4.9
b) Broadleaved species that are shallow rooting and/or resilient to frequent waterlogging include: trees from Hart (1991)

the Salix (willow) family, Betula (birch) family, Sorbus aucuparia (rowan/mountain ash) and Alnus
glutinosa (alder)

c) Conifer species that are shallow rooting and/or resilient to frequent waterlogging include: Picea sitchensis
(Sitka spruce) and Picea abies (Norway spruce)

d) Select a tree species that forms low branches (see Figures 4.6 and 4.9) to increase floodplain roughness and
turbulence/flow disruption by creating a physical barrier low to the ground

e) Select a tree species that forms a low crown (see Figures 4.6 and 4.9) to increase floodplain roughness and
turbulence/flow disruption by creating a physical barrier low to the ground

Nisbet and Thomas (2008)
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Ref.
The choice of silvicultural regime and woodland management practice can have a significant impact on the
hydraulic and hydrological properties of woodland, potentially affecting both runoff reduction and flood storage
ecosystem services. The following technical guidance should be considered in the design and management of
floodplain and wider catchment woodland planting measures at sites identified through the flood control and
hydrological cycle models:
a) Urban woodland should be structurally diverse and incorporate: 1) a closed canopy; 2) an understorey of
shrubs and/or shrubby trees such as Corylus avellana (hazel) and trees from the Salix (willow) family; and
3) the retention of deadwood on the woodland floor
b) Where possible (e.g. given landscape and biodiversity constraints), the use of closed canopy conifer stands
should be promoted given their year round foliage and strong support for multiple natural drainage
processes (especially interception, evapotranspiration and attenuation)
c) Adopt continuous cover forestry (CCF) silvicultural practices where possible to increase structural diversity | Section 4.6

Flood L and the area of land under continuous woodland cover Figures 4.6 and 4.9
- d) Adopt a hierarchy of different woodland design and management strategies for different circumstances - Hart (1991)
the use of closed canopy conifer stands is likely to be the most preferential type of woodland in terms of Nisbet and Thomas (2008)

water management though not appropriate for all sites. Where this strategy is inappropriate, the following
alternatives should be considered:
i Native broadleaf with non-native conifer CCF
ii. Native broadleaf CCF
iii. Native broadleaf CCF with areas of openspace, noting that areas of openspace should ideally be
managed in line with Hydro_F (c) and (d)
e) Where possible, dead trees and brash from any harvesting and management operations should be retained
on site to help maintain hydraulic roughness (see Figure 4.9)
f)  Mounding can be used to provide increased depth for tree rooting and may facilitate the planting of species
that would otherwise not thrive in such wet conditions. Mounding also provides a physical barrier to flood
waters and will contribute to increased hydraulic roughness
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Appendix 5: Guidance for
Interpreting and acting on
hydrological cycle model outputs
In the development of integrated
urban land use/management
strategies
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Introduction to the hydrological cycle model guidance

The table below provides specific technical guidance to help practitioners
interpret and act on hydrological cycle model outputs in the development of
integrated urban land use/management strategies. In essence, these are practical
recommendations describing how runoff reduction ecosystem services can be
enhanced, at sites and locations identified through the hydrological cycle model,
through targeted land use/management intervention.

The guidance has been developed through this research on the basis of the material
collated, analysed and synthesised in the evidence assessment described in Chapters
3, 4, 5 and 6. The analysis approach used in the development of the guidance is
described at section 8.1.1 in the main volume of the thesis. Further information on
the utility of the technical guidance supporting urban land use/management
planning, including worked examples, is provided at sections 8.2 and 8.3 in the
main volume of the thesis.

The table includes references to indicate the provenance of the guidance notes
within specific parts of the evidence assessment in the main volume of the thesis or
specific key references (e.g. journal articles, official reports, government policy etc)
that have played a crucial role within the evidence assessment. The references are
intended to signpost the reader to more detailed information that can support
consideration of the guidance in practical urban land use/management planning.

Appendix 4 includes more general overarching guidance to support the
consideration of runoff reduction and flood storage ecosystem services in urban
land use/management planning. This is in addition to the general ecosystems
approach principles described at Appendix 3. Further information on the utility of
the overarching guidance supporting urban land use/management planning,
including worked examples, is provided at sections 8.2 and 8.3 in the main volume
of the thesis.
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Technical guidance for interpreting and acting on hydrological cycle model outputs in the development of integrated urban
land use/management strategies

Ref. Technical guidance Reference(s)

Identify possible synergies and areas of overlap between LDP related land use/management proposals (as

identified through the modelling) and objectives, policies, actions etc from related land use delivery = e ez el

(Appendix 3 and section

Hydro A mechanisms, especially: 1) Scottish Planning Policy (SPP); 2) Strategic Development Plans; 3) relevant 3.1.1)
Development Management decisions; 4) River Basin Management Plans (RBMPs); 5) Flood Risk Management F'i 'ure 31
Strategies; and 6) Scotland's Land Use Strategy. Where relevant, consider how these opportunities can be Phgillips ét al (2014)

developed through partnership working and the use of formalised partnership agreements

For areas of existing 'green’ and ‘natural’ environment type land use identified through the hydrological cycle
model, consider how interception and attenuation capacity can be enhanced or restored by:
a) Increasing tree cover/density on the site - in general terms, trees and woodlands intercept more
precipitation than shorter types of vegetation (shrubs and grasses)
b) Restructuring sites with significant existing woodland cover (e.g. certain types of natural/semi-natural
: o . . . - Tables 4.6 and 4.7
Hydro B greenspace and green corridor site in terms of PANG5) to include a greater proportion of conifer species Fiure 4.14
(e.g. Picea sitchensis and Pinus slyvestris etc) g ,
. L . _ AECOM (2011)
c) Altering the management of existing amenity grassland (e.g. as found within parks and gardens and -

. : A i . . Scottish Government (2008)
amenity greenspace) to support the creation of species rich grassland/meadow, noting that interception
losses from dense grasses and herbs can be as much as broadleaved tree species. The subsequent change in
management regime would see a greater sward height for longer and therefore greater hydraulic roughness
and interception losses

Sections 4.7.1 and 4.7.2

For areas of existing 'green’ and 'natural’ environment type land use identified through the hydrological cycle Sections 4.7.1 and 4.7.2

model, consider how evapotranspiration capacity can be enhanced or restored by: Tables 4.6 and 4.7
Hydro C f) Increasing the density of all types of vegetation cover on the site including trees, shrubs and grasses Fiure 4'1 4 ‘
g) Restructuring sites with significant existing woodland cover (e.g. certain types of natural/semi-natural AI%COM (2011)

greenspace and green corridor site in terms of PANG65) to include a greater proportion of conifer species

(e.g. Picea sitchensis and Pinus slyvestris etc) SEDIET EOEEr ()
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Ref.

Hydro D

Hydro E

Technical guidance Reference(s

For areas of existing 'green’ and 'natural’ environment type land use identified through the hydrological cycle

model, consider how infiltration can be enhanced or restored by:

a) Increasing the density of all types of vegetation cover on the site including trees, shrubs and grasses to help
protect soil porosity and infiltration capacity

b) Where appropriate, changing land use to woodland - woodland soils often have a more open structure and
therefore greater porosity and infiltration capacity

c) Restructuring sites with significant existing woodland cover (e.g. certain types of natural/semi-natural
greenspace and green corridor site in terms of PANG5) to include a greater proportion of conifer species
(e.g. Picea sitchensis and Pinus slyvestris etc)

For existing natural/semi-natural greenspace and green corridor sites identified through the hydrological

cycle model and in local authority ownership, consider how drainage function can be enhanced or restored by:

a) Increasing tree cover/density on the site - in general terms, trees and woodlands intercept more
precipitation than shorter types of vegetation (e.g. shrubs and grasses)

b) Restructuring sites with significant existing woodland cover (e.g. certain types of natural/semi-natural
greenspace and green corridor site in terms of PANG65) to include a greater proportion of conifer species
(e.g. Picea sitchensis and Pinus slyvestris)

c) For sites with significant existing woodland cover, change management regime to continuous cover
forestry (CCF)

d) Increasing the density of all types of vegetation cover on the site including trees, shrubs and grasses

e) Where appropriate, changing land use to woodland (e.g. for grassland sites with low ecological value - i.e.
woodland soils tend to have a more open structure and therefore greater porosity and infiltration capacity

f) Reverse land drainage and promote the creation of wetland and wet flush areas including wet woodland

g) Installing/retrofitting regional control SUDS measures (e.g. retention basins and associated wetland habitat)
- the use of regional control SuDS in this regard could be designed to provide part of the surface water
management solution for other land uses surrounding the area of natural/semi-natural greenspace (e.g.
housing, business, roads etc)

Sections 4.7.1 and 4.7.2
Tables 4.6 and 4.7

Figure 4.14

AECOM (2011)

Scottish Government (2008)
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Ref.

Hydro F

Hydro G

Technical guidance Reference(s

For existing public park and garden sites (potentially incorporating areas of playspace for children and
teenagers) identified through the hydrological cycle model and in local authority ownership, consider how
drainage function can be enhanced or restored by:

a)
b)

c)
d)

e)

9)

Increasing tree cover/density on the site - in general terms, trees and woodlands intercept more
precipitation than shorter types of vegetation (e.g. shrubs and grasses)

Restructuring parts of the site with significant existing woodland cover to include a greater proportion of
conifer species (e.g. Picea sitchensis and Pinus slyvestris)

Increasing the density of all types of vegetation cover on the site including trees, shrubs and grasses (where
appropriate given the site's primary use)

Altering the management of some or all of the site's existing amenity grassland to support the creation of
species rich grassland/meadow — these new areas of habitat should be integrated with existing habitat
networks where possible

Installing/retrofitting source control SuDS measures (e.g. green roofs on cafes, permeable surfaces, rain
gardens etc) within areas of public realm and civic space (i.e. parts of the site where there are significant
areas of hardstanding)

Installing/retrofitting site control SUDS measures (e.g. detention basins) that are fully integrated with the
site's existing use(s) and other surface water management infrastructure (i.e. source and regional control
SuDS)

Installing/retrofitting regional control SuDS measures (e.g. retention basins and associated wetland habitat)
- the use of regional control SuDS in this regard could be designed to provide part of the surface water
management solution for other land uses surrounding the park (e.g. housing, business, roads etc)

Sections 4.7.1, 4.7.2 and 4.7.3
Tables 4.6, 4.7 and 4.8
Figures 4.14, 4.15 and 4.17
AECOM (2011)

Scottish Government (2008)
Scottish Government (2011d)

For existing allotments and community growing space sites identified through the hydrological cycle model
and in mixed ownership (e.g. owned by the local authority, leased/owned by a community group etc), consider
how drainage function can be enhanced or restored by:

a)

b)

c)

Where appropriate, using policy (e.g. planning policy within the LDP) and grants/incentives to increase Sections 4.7.1, 4.7.2 and 4.7.3
tree cover/density on the site - in general terms, trees and woodlands intercept more precipitation than Tables 4.6, 4.7 and 4.8
shorter types of vegetation (e.g. shrubs and grasses) Figures 4.14, 4.15 and 4.17
Where appropriate, using policy (e.g. planning policy within the LDP) and grants/incentives to increase the | AECOM (2011)

density of all types of vegetation cover on the site including trees, shrubs and grasses Scottish Government (2008)

Where appropriate, using policy (e.g. planning policy within the LDP) and grants/incentives to promote the
installation of source control SUDS measures (e.g. green roofs, permeable surfaces, rain gardens etc) on the
site
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Ref.

Hydro H

Hydro_I

Hydro_J

Technical guidance Reference(s

For existing private gardens and grounds identified through the hydrological cycle model and in private

ownership, consider how drainage function can be enhanced or restored by:

a) Using policy (e.g. planning policy within the LDP) and grants/incentives to promote the installation of
source control SuDS measures (e.g. green roofs, permeable surfaces, rain gardens etc) on the site

For existing sports area sites identified through the hydrological cycle model and in local authority

ownership, consider how drainage function can be enhanced or restored by:

a) Increasing tree cover/density on the site - in general terms, trees and woodlands intercept more
precipitation than shorter types of vegetation (e.g. shrubs and grasses). This could include planting up of
discrete woodland blocks across the site where existing primary use would allow - these new areas of
habitat should be integrated with existing habitat networks where possible

b) Restructuring parts of the site with significant existing woodland cover to include a greater proportion of
conifer species (e.g. Picea sitchensis and Pinus slyvestris)

c) Altering the management of some or all of the site's existing amenity grassland to support the creation of
species rich grassland/meadow - these new areas of habitat should be integrated with existing habitat
networks where possible

d) Increasing the density of all types of vegetation cover on the site including trees, shrubs and grasses. This
could include the creation of discrete areas of species rich grassland/wildflower meadow where existing use
would allow - these new areas of habitat should be integrated with existing habitat networks where possible

e) Installing/retrofitting source control SUDS measures (e.g. green roofs on buildings, permeable surfaces, rain
gardens etc) within areas of public realm and civic space (i.e. parts of the site where there are significant
areas of hardstanding)

f) Installing/retrofitting site control SUDS measures (e.g. detention basins) that are fully integrated with the
site's existing use(s) and other surface water management infrastructure (i.e. source and regional control
SuDS)

g) Installing/retrofitting regional control SUDS measures (e.g. retention basins and associated wetland habitat)
- the use of regional control SuDS in this regard could be designed to provide part of the surface water
management solution for other land uses surrounding the sports area (e.g. housing, business, roads etc)

For existing amenity greenspace sites identified through the hydrological cycle model and in mixed

ownership (e.g. local authority, housing association, business association etc), consider how drainage function

can be enhanced or restored by:

a) Increasing tree cover/density on the site - in general terms, trees and woodlands intercept more
precipitation than shorter types of vegetation (e.g. shrubs and grasses). This could include planting up of

Sections 4.7.1, 4.7.2 and 4.7.3
Tables 4.6, 4.7 and 4.8
Figures 4.14, 4.15 and 4.17
AECOM (2011)

Scottish Government (2008)

Sections 4.7.1, 4.7.2 and 4.7.3
Tables 4.6, 4.7 and 4.8
Figures 4.14, 4.15 and 4.17
AECOM (2011)

Scottish Government (2008)
Scottish Government (2011d)

Sections 4.7.1, 4.7.2 and 4.7.3
Tables 4.6, 4.7 and 4.8
Figures 4.14, 4.15 and 4.17
AECOM (2011)

Scottish Government (2008)
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Ref.
discrete woodland blocks across the site where existing use would allow - these new areas of habitat should
be integrated with existing habitat networks where possible

b) Restructure parts of the site with significant existing woodland cover to include a greater proportion of
conifer species (e.g. Picea sitchensis and Pinus slyvestris)

c) Altering the management of some or all of the site's existing amenity grassland to support the creation of
species rich grassland/meadow - these new areas of habitat should be integrated with existing habitat
networks where possible

d) Increasing the density of all types of vegetation cover on the site including trees, shrubs and grasses

e) Installing/retrofitting source control SUDS measures (e.g. green roofs on housing and offices, permeable
surfaces, rain gardens etc) within areas of public realm and civic space (i.e. parts of the site where there are
significant areas of hardstanding)

f) Installing/retrofitting site control SUDS measures (e.g. detention basins) that are fully integrated with the
site's existing use(s) and other surface water management infrastructure (e.g. source control SuDS)

g) Installing/retrofitting regional control SUDS measures (e.g. retention basins and associated wetland habitat)
- this could be designed to provide part of the surface water management solution for the development (e.g.
housing, business, roads etc) associated with the area of amenity greenspace

For areas of urban land use identified through the hydrological cycle model that are not 'green' and 'natural
environment' type land uses (e.g. areas of public realm, roads, buildings, school/hospital estates etc) that are
primarily in public ownership, consider how drainage function can be enhanced or restored by:

a) Installing/retrofitting source control SUDS measures (e.g. green roofs, permeable surfaces, rain gardens) Sections 4.7.1, 4.7.2 and 4.7.3
noting that the nature of source control SuDS measures is such that their use can be considered at any Tables 4.6, 4.7 and 4.8
Hydro_K location e.g. within areas of public realm, car parks, pavements, roads etc. Source control SuDS may be Figures 4.14, 4.15 and 4.17
particularly useful where existing land use constrains the installation/retrofit of site control SuDS (though AECOM (2011)
runoff from source control SUDS may have to be conveyed off-site to site/regional control SuDS assets Scottish Government (2008)

depending on anticipated runoff volumes and the level of treatment that can be achieved at source)
b) Where existing land use allows, installing/retrofitting site control SuDS measures (e.g. detention basins)
within developments e.g. housing estates, business parks, school estates etc

The choice of silvicultural regime and woodland management practice can have a significant impact on the
hydraulic and hydrological properties of woodland, potentially affecting both runoff reduction and flood storage | Section 4.6

Hvdro L ecosystem services. The following technical guidance should be considered in the design and management of Figures 4.6 and 4.9
yaro_ floodplain and wider catchment woodland planting measures at sites identified through the flood control and Hart (1991)
hydrological cycle models: Nisbet and Thomas (2008)

g) Urban woodland should be structurally diverse and incorporate: 1) a closed canopy; 2) an understorey of
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shrubs and/or shrubby trees such as Corylus avellana (hazel) and trees from the Salix (willow) family; and
3) the retention of deadwood on the woodland floor

h) Where possible (e.g. given landscape and biodiversity constraints), the use of closed canopy conifer stands
should be promoted given their year round foliage and strong support for multiple natural drainage
processes (especially interception, evapotranspiration and attenuation)

i)  Adopt continuous cover forestry (CCF) silvicultural practices where possible to increase structural diversity
and the area of land under continuous woodland cover

j)  Adopt a hierarchy of different woodland design and management strategies for different circumstances -
the use of closed canopy conifer stands is likely to be the most preferential type of woodland in terms of
water management though not appropriate for all sites. Where this strategy is inappropriate, the following
alternatives should be considered:

i Native broadleaf with non-native conifer CCF
ii. Native broadleaf CCF
iii. Native broadleaf CCF with areas of openspace, noting that areas of openspace should ideally be
managed in line with Hydro_F (c) and (d)

k) Where possible, dead trees and brash from any harvesting and management operations should be retained
on site to help maintain hydraulic roughness (see Figure 4.9)

I)  Mounding can be used to provide increased depth for tree rooting and may facilitate the planting of species
that would otherwise not thrive in such wet conditions. Mounding also provides a physical barrier to flood
waters and will contribute to increased hydraulic roughness
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Appendix 6: Guidance for
Interpreting and acting on
habitat network model outputs In
the development of integrated
urban land use/management
strategies
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Introduction to the habitat network model guidance

The tables below provide guidance to support the consideration of ecological
connectivity ecosystem services in urban land use/management planning. The
guidance has been developed through this research on the basis of the material
collated, analysed and synthesised in the evidence assessment described in Chapters
3, 4, 5 and 6. The analysis approach used in the development of the guidance is
described at section 8.1.1 in the main volume of the thesis.

The tables include references to indicate the provenance of the guidance notes
within specific parts of the evidence assessment in the main volume of the thesis or
specific key references (e.g. journal articles, official reports, government policy etc)
that have played a crucial role within the evidence assessment. The references are
intended to signpost the reader to more detailed information that can support
consideration of the guidance in practical urban land use/management planning.

The first table provides overarching guidance for the consideration of ecological
connectivity services in urban land use/management planning. In essence, these are
key principles that can help stakeholders integrate consideration of ecological
connectivity ecosystem services within urban land use/management plans. This is
in addition to the general ecosystems approach principles described at Appendix 3.
Further information on the utility of the overarching guidance supporting urban
land use/management planning, including worked examples, is provided at sections
8.2 and 8.3 in the main volume of the thesis. The overarching guidance notes are
grouped into the following categories:

1. Approaches and concepts;

2. Tools, policy and regulation;
3. Resilience and flexibility; and
4. Planning and intervention.

The second table provides specific technical guidance to help practitioners
interpret and act on habitat network model outputs in the development of
integrated urban land use/management strategies. In essence, these are practical
recommendations describing how ecological connectivity ecosystem services can
be enhanced, at sites and locations identified through the hydrological cycle model,
through targeted land use/management intervention. Further information on the
utility of the technical guidance supporting urban land use/management planning,
including worked examples, is provided at sections 8.2 and 8.3 in the main volume
of the thesis.

The overarching guidance notes are distinguished by a number suffix e.g.
Habitat_1.

The technical guidance notes are distinguished by a letter suffix e.g. Habitat_A.
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Overarching guidance for the consideration of ecological connectivity ecosystem services in urban land use/management

planning
Ref. Reference(s)
Overarching Guidance Category No.1: Approaches and Concepts
Within the development of urban land use/management strategies, including Local Development Plans (LDPs),
Habitat 1 stakeholders should approach urban landscapes as entities comprising structural elements of patch, mosaic, Section 5.1.1
el corridor and barrier. Thinking in these terms can support better planning for landscape connectivity for species - o
. . . . . Figure 5.1
and biodiversity conservation but also for people movements and other ecosystem processes/intermediate
services
For land use planning/management purposes, consider how the urban landscape can be measured and evaluated
Habitat 2 in terms of relevant habitat metrics (e.g. total area of habitat, mean size of habitat patches, mean inter-patch .
— . . . . . Section 5.1.2
distance etc) to better understand the opportunities and constraints for species movements and ecological
connectivity
Overarching Guidance Category No.2: Tools, Policy and Regulation
Use the statutory planning system, including Local Development Plan (LDP) policy, Development Management Section 4.2
Habitat 3 and Enforcement, to protect and enhance land and green infrastructure that provides ecological connectivity Table 4 2'
ecosystem services '
Where relevant, consider how the statutory planning system can be used to provide new areas of 'green' and
Habitat 4 ‘natural environment' type urban land use (i.e. appropriately sited and designed multifunctional openspace as per | Section 4.2
- PANG5) and green infrastructure for the provision of ecological connectivity ecosystem services (e.g. through Table 4.2
planning conditions, section 106 agreements etc)
Overarching Guidance Category No.3: Resilience and Flexibility
Urban land use/management strategies, including Local Development Plans (LDPs), should seek to protect, Section 5.2.1

Habitat_5 restore and enhance structural and functional connectivity in habitat networks

Urban land use/management planning for the restoration of ecosystem structure and function (e.g. hydrological
Habitat 6 cycle function) and enhancement of ecosystem services (e.g. runoff reduction) should be undertaken at a range
of scales including at the landscape or whole ecosystem scale

Figures 5.2, 5.3 and 5.5

Sections 3.1.3 and 5.1.1
Expert interview data
(Appendix 3 and section
3.1.3)

Figures 3.4 and 3.5
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Ref. Overarching guidance Reference(s

Tables 3.4 and 4.7

Overarching Guidance Category No.4: Planning and intervention

Where possible, habitat network protection, enhancement and restoration measures should be designed to
support as wide a range of native species as possible. In habitat network modelling this can be facilitated
Habitat_7 through the use of a Generic Focal Species (GFS) designed to capture a broad range of objectives (e.g. Section 5.1.1 and 5.2.2
conservation, landscape, climate change adaptation). In any event, habitat networks should be designed to
support priority species (e.g. those identified in the UKBAP, the relevant LBAP etc)

Use sensitivity analysis in habitat network modelling (e.g. running models using a range of different parameters
for patch size and dispersal distance) to reflect the uncertainty inherent to the modelling techniques used (e.g.
Habitat 8 lack of data on species ecology, over reliance on Generic Focal Species etc). Model outputs produced through Section 5.2.2
analyses using a range of different parameters can then be evaluated before habitat network model data is used
to inform urban land use/management strategies, including Local Development Plans (LDPs)

Technical guidance for interpreting and acting on habitat network model outputs in the development of integrated urban land
use/management strategies

Ref. Technical guidance Reference(s)

Identify possible synergies and areas of overlap between LDP related land use/management proposals (as
identified through the modelling) and objectives, policies, actions etc from related land use delivery

Habitat_A mechanisms, especially: 1) Scottish Planning Policy (SPP); 2) Strategic Development Plans; 3) relevant
Development Management decisions; 4) River Basin Management Plans (RBMPs); 5) Flood Risk Management
Strategies; and 6) Scotland's Land Use Strategy. Where relevant, consider how these opportunities can be
developed through partnership working and the use of formalised partnership agreements

Expert interview data
(Appendix 3 and section
3.1.1)

Figure 3.1

Phillips et al (2014)

381



Land use planning in urban areas — towards an ecosystems approach
Peter M. Phillips, Department of Civil and Environmental Engineering, University of Strathclyde

Ref.

Habitat B

Habitat C

Habitat_D

Technical guidance Reference(s

First priority: Existing habitat patches identified through the habitat networks model should be the priority
for land use/management intervention that enhances ecological networks. In the first instance, areas of high
quality habitat that are not protected or in active management should be improved (e.g. afforded protection
through planning policy and brought back into active management). Following this, areas of habitat with
restoration potential should be restored and improved. Both of these interventions will require a degree of
ground-truthing beyond the outputs of the habitat networks model - e.g. to assess habitat quality and identify
required management intervention. Where possible, all habitat network management activities should be fully
integrated with water management related land use/management and green infrastructure intervention (see
Appendices 7 and 8) and designed to deliver a broad range of other ecosystem services, as required given the
specific context

Second priority: Land use intensity within existing functional habitat networks identified through the
habitat networks model should be maintained or reduced to improve the landscape matrix (e.g. adoption of
specific planning policy to protect existing connectivity). This can have the effect of maintaining or improving
ecological connectivity - i.e. areas of 'low-cost' matrix should be maintained where possible. Where possible, all
habitat network management activities should be fully integrated with water management related land
use/management and green infrastructure intervention (see Appendices 7 and 8) and designed to deliver a broad
range of other ecosystem services, as required given the specific context

Third priority: Land use intensity adjacent to existing functional habitat networks identified through the
habitat networks model should be reduced to improve the landscape matrix (e.g. adoption of specific planning
policy to protect existing connectivity, improving the management of isolated patches that are not functionally
connected). This can have the effect of improving ecological connectivity by increasing functional connectivity
- i.e. areas of 'low-cost' matrix should be increased where possible. Where possible, all habitat network
management activities should be fully integrated with water management related land use/management and
green infrastructure intervention (see Appendices 7 and 8) and designed to deliver a broad range of other
ecosystem services, as required given the specific context

Sections 5.2.2 and 5.3
Tables 5.1 and 5.2

Figures 5.2, 5.3,5.4 and 5.5
Smith et al (2008)

Sections 5.2.2 and 5.3
Tables 5.1 and 5.2

Figures 5.2, 5.3,5.4 and 5.5
Smith et al (2008)

Sections 5.2.2 and 5.3
Tables 5.1 and 5.2

Figures 5.2,5.3,5.4and 5.5
Smith et al (2008)
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Ref. Technical guidance

Fourth priority: The creation/recreation of new areas of natural/semi-natural habitat should be considered

within existing functional habitat networks identified through the habitat networks model. This can have the Sections 5.2.2 and 5.3

effect of improving ecological connectivity by increasing functional connectivity (i.e. the addition of new Tables 5.1 and 5.2
Habitat E patches can have the effect of increasing the total area of functionally connected habitat/contiguous habitat . : '
= . . L . - Figures 5.2, 5.3, 5.4 and 5.5
network). Where possible, all habitat network management activities should be fully integrated with water Smith et al (2008)

management related land use/management and green infrastructure intervention (see Appendices 7 and 8) and
designed to deliver a broad range of other ecosystem services, as required given the specific context
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Appendix 7: Evaluation of
existing ecosystems approach
based land use planning
frameworks
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Key to scoring

Case study ecosystems approach based urban land use planning frameworks

COZQ&%'P;S THESAURUS EERA Green Network Opportunities Mapping
Considered References: Collingwood Environmental Planning and References: East of England Regional Assembly, 2007; References: GCV Green Network Partnership, 2011;
to a degree Geodata Institute, 2008a; Defra, 2008; Sheate et al, 2012 East of England Regional Assembly, 2008 GCV Strategic Development Planning Authority, 2011
Principle not
considered
Ecosystems o o o
approach S o) o)
principle @ Summary comments/rationale @ Summary comments/rationale @ Summary comments/rationale
EsA 1. To a degree — the ecosystem service typology To a degree — the EERA approach recommends To a degree — the approach is designed
Consider adopted in the THESAURUS approach considers that additional spatial environmental information primarily for use in an urban context with a
effects on key ecosystem processes and intermediate is used in conjunction with environmental limits focus on urban greenspace enhancement, access
adjacent services® including hydrological cycling and maps for the study area (see ESA 3). The improvements and meeting the greenspace/green
ecosystems wildlife habitats/networks. Although not stated intention is to provide a wider contextual infrastructure needs of new development. In this
explicitly, these services are likely to have understanding (e.g. in spatial terms) of the regard, opportunities to think strategically about
implications beyond the boundaries of single implications for spatial planning. The approach effects on adjacent ecosystems are limited.
ecosystems e.g. strategic habitat networks, also considers broader scale issues beyond the However, the approach does include provision
hydrological cycle impacts of vegetation on geographical scope of the study area including for consideration of wider/landscape scale issues
adjacent catchments (transpiration and “opportunities to import, recreate or substitute through the analysis of individual high scoring
transportation of water) etc the services [provided by the study area]” cells (i.e. clustered priorities where multiple high
(EERA, 2008 p.20) scoring cells cluster together are generally
focussed around urban areas with multiple green
network issues). These cells often represent
habitat enhancement opportunities in the wider
countryside
EsA 2. Principle considered — as per the above, the To adegree — EERA’s approach to mapping To a degree — the approach includes some
Conserve ecosystem service typology incorporates key environmental limits (see EsA 3) is based on consideration of ecosystem structure and
ecosystem ecosystem processes/intermediate services, many state based indicators for discrete environmental function issues though the focus is very much on
structure and of which are key for ecosystem structure and topics taken from strategic environmental ecological connectivity (i.e. joining up areas of
function function. Crucially, natural succession is also assessment (SEA) legislation®. This sort of topic fragmented habitat) as opposed to wider
considered, exemplifying the importance of based approach works against the integrated ecosystem processes/intermediate services such
ecosystem structure i.e. maintaining diversity in nature of ecosystems though there is recognition as water cycling and soil formation (see section
ecosystem structure by natural processes that the approach has been dictated by data 3.2.2). Consideration of ESA 2 type issues is
availability i.e. the data required to support facilitated through the use of a biodiversity
ecosystem service based indicators wasn’t opportunities layer that “identifies locations
available (see section 3.2.1). Ecosystem function where intervention would yield the greatest

! The typology and definition of ecosystem services considered in this research is provided at section 3.2.2
2 See Annex | of the EC SEA Directive: http://eur-lex.europa.eu/LexUriServ/LexUriServ.do?uri=0J:L:2001:197:0030:0037:EN:PDF [accessed 01/02/14]
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Key to scoring

Case study ecosystems approach based urban land use planning frameworks

COZQ&SP;S THESAURUS EERA Green Network Opportunities Mapping
Considered References: Collingwood Environmental Planning and References: East of England Regional Assembly, 2007; References: GCV Green Network Partnership, 2011;
to a degree Geodata Institute, 2008a; Defra, 2008; Sheate et al, 2012 East of England Regional Assembly, 2008 GCV Strategic Development Planning Authority, 2011
Principle not
considered
Ecosystems o o o
approach I o) 8
principle @ Summary comments/rationale @ Summary comments/rationale @ Summary comments/rationale
issues are picked up to a degree by some of the benefit in terms of improving habitat
topic indicators e.g. land and marine based flora connectivity” (GCV Green Network Partnership,
and fauna considers ecosystem resilience and 2011 p.13)
stability issues
EsA 3. Principle not considered (either explicitly or Principle considered — consideration of Principle not considered (either explicitly or
Ecosystem implicitly) environmental limits and capacity is the key implicitly)
management objective of the EERA approach. Environmental

must respect
environmental
limits

limits are defined using state based indicators
(see section 3.2.1) for key environmental
issues/topics (see EsA 2) drawing on readily
available data. A two phase model is used where
the issue/topic is described as either within or
exceeded in relation to the defined limit. Limits
are identified with reference to literature, policy
and through stakeholder engagement

EsA 4.
Adopt the
ecosystems
approach at
appropriate
spatial and
temporal

To a degree — the approach recognises how a
“typology of ecosystem services can be
developed for any location and at any scale”
(Sheate et al, 2012 p.7). There is also
consideration of how different stakeholders can
help understand the context specific value of
ecosystem services at different scales. Crucially

Principle considered — the approach is designed
to operate at the regional/sub-regional scale.
Although this will be defined by administrative
boundaries (i.e. the Regional Spatial Strategy
area), such a broad scale will likely encompass
key natural features e.g. strategic ecological
networks, catchments etc. Indeed there is explicit

Principle considered — the approach includes
extensive consideration of issues relating to
spatial scale. The GIS based element is designed
for use at the local authority® scale though it
identifies priorities/opportunity areas at the local
scale. For example, the analysis undertaken for
the West Dunbartonshire Council (WDC) area

% Local authorities in Scotland are responsible for the provision of a range of services such as roads and transport, education, social work, economic development,
housing and environment. They are administrative regions that represent Scotland’s diversity in population distribution (and therefore other geographical issues by
proxy e.g. topography, accessibility, remoteness etc). For example, Dundee City Council is only 26m? in area whereas the Highlands Council is 12, 437m?.

Unsurprisingly, the former is also much more densely populated than the latter. As such, although there is no one size fits all definition of local authority spatial scale,

local authority areas are likely to be sufficiently broad such that they encompass key natural features like water catchments and strategic ecological networks:

http://www.scotland.gov.uk/Topics/Government/local-government/localg [accessed 03/02/14]
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Case study ecosystems approach based urban land use planning frameworks

Key to scoring

Principle
considered

THESAURUS

EERA

Green Network Opportunities Mapping

Considered
to a degree
Principle not
considered

References: Collingwood Environmental Planning and
Geodata Institute, 2008a; Defra, 2008; Sheate et al, 2012

References: East of England Regional Assembly, 2007;
East of England Regional Assembly, 2008

References: GCV Green Network Partnership, 2011;
GCV Strategic Development Planning Authority, 2011

Ecosystems
approach
principle Summary comments/rationale

Score

Score

Summary comments/rationale

scale the approach has also been tested at different
scales — sub-regional (i.e. the whole of the Kent
Thameside area) and local (i.e. for a specific
settlement within the study area). There is no
specific consideration of the ecological rationale
for using different scales and neither is there any
reference to temporal issues

recognition of how “consideration of
environmental limits requires thinking at a broad
spatial scale” (EERA, 2008 p.8). Crucially, the
EERA approach also considers temporal scale
issues including the need to balance land use
conflicts in time and space. The consideration of
pressures and trends in relation to the
environmental issues/topics for which limits
have been defined is an additional temporal
element

EsSA 5. Principle not considered (either explicitly or To a degree — as per ESA 4 above, the EERA

Set long term implicitly) approach incorporates consideration of key

objectives for temporal scale issues. Specific timescales are not

ecosystem defined however (e.g. quantifying what is meant

management by long term in relation to environmental
pressures and trends as well as objectives for
spatial planning)

EsA 6. Principle not considered (either explicitly or Principle not considered (either explicitly or

Ecosystem implicitly) implicitly)

management

must

recognise that

change is

inevitable

Score

Summary comments/rationale

identified four hotspots for green network
intervention at either the town and
neighbourhood scale. Similarly, outputs are
designed to feed into LDP policy at broader
scales as well as informing masterplans, design
studies and, ultimately, Development
Management decisions at the neighbourhood and
site scales (see section 3.1.3). Temporal scale
issues are considered implicitly as the outputs of
the approach are designed to inform LDP green
network policy. In this regard, green network
policy (as with other areas of policy within the
LDP) should focus on proposals up to year 10
from the LDP’s adoption (Scottish Government,
2009b)

To a degree — as per ESA 4 above, the approach
incorporates implicit consideration of key
temporal scale issues though specific timescales
are not defined. In essence though, this would be
the role of the local authority (i.e. the green
network opportunities mapping is undertaken by
the GCV Green Network Partnership on behalf
of the eight local authorities within the GCV
region)

Principle not considered (either explicitly or
implicitly)
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Key to scoring

Case study ecosystems approach based urban land use planning frameworks

coigiz(zgs THESAURUS EERA Green Network Opportunities Mapping
Considered References: Collingwood Environmental Planning and References: East of England Regional Assembly, 2007; References: GCV Green Network Partnership, 2011;
to a degree Geodata Institute, 2008a; Defra, 2008; Sheate et al, 2012 East of England Regional Assembly, 2008 GCV Strategic Development Planning Authority, 2011
Principle not
considered
Ecosystems o o o
approach S o) o)
principle @ Summary comments/rationale @ Summary comments/rationale @ Summary comments/rationale
EsA 7. To a degree — a key part of the rationale for this To a degree — there is a strong emphasis on the Principle considered — the approach has a
Understand approach is recognition that ecosystem services value and importance of ecosystem services distinct focus on the need to understand and
and manage are context specific (i.e. ecosystem services are including recognition that “large sections of the manage green networks and the urban natural
the ecosystem more or less valuable depending on a range of economy are dependent on a high quality natural environment in an economic context. In
inan contextual issues such as population density, environment” (EERA, 2008 p.7). Operationally, particular, the GIS analysis seeks to answer the
economic flood risk, soils etc). Context in this regard can the approach has been designed to facilitate the question “where are the major areas of land use
context also include consideration of existing planning transparent consideration of conflicts and trade- change” (GCV Green Network Partnership, 2011
and management arrangements for ecosystems offs between different ecosystem services (or p.11) through the use of spatial datasets on
including key economic issues such as costs aspects of the environment providing the development and regeneration sites. In essence,
associated with land management for a given services) including the use of sensitivity analysis areas of change and investment are regarded as
level of service in the GIS mapping of environmental limits (e.g. opportunities for the enhancement of ecosystems
to explore stakeholder preferences for specific and ecosystem services (e.g. through the creation
services). However there is no specific of habitat mosaics that are integrated with
consideration of costs and benefits development to provide key ecosystem services
such as water management, climate regulation
and environmental settings). There is also a
particular focus on the role of the planning
system delivering “multiple green network
[ecosystem service] benefits through the
targeting of resources” (GCV Green Network
Partnership, 2011 p.18). Other than ecological
connectivity and access networks/recreation
however the approach does not include provision
for the spatial analysis/targeting of any other
ecosystem services
EsA 8. To a degree — biodiversity (and other important Principle not considered — biodiversity issues Principle not considered — biodiversity issues
Ensure an elements of biodiversity including habitats, are incorporated to a degree within the selection are incorporated to a degree within the
appropriate semi-natural greenspace and ecological of state indicators for mapping environmental biodiversity opportunities dataset though there is
balance networks) is incorporated within the ecosystem limits (i.e. land and marine based flora and no specific method, approach or mechanism
between service typology adopted in this approach. fauna). However there is no specific method, identified for balancing conservation with use of
conservation However there is no specific method, approach approach or mechanism identified for balancing biodiversity
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Key to scoring

Case study ecosystems approach based urban land use planning frameworks

COZQ&%'P;S THESAURUS EERA Green Network Opportunities Mapping
Considered References: Collingwood Environmental Planning and References: East of England Regional Assembly, 2007; References: GCV Green Network Partnership, 2011;
to a degree Geodata Institute, 2008a; Defra, 2008; Sheate et al, 2012 East of England Regional Assembly, 2008 GCV Strategic Development Planning Authority, 2011
Principle not
considered
Ecosystems o o o
approach S o) o)
principle @ Summary comments/rationale @ Summary comments/rationale @ Summary comments/rationale
and use of or mechanism identified for balancing conservation with use of biodiversity
biodiversity conservation with use of biodiversity
EsA9. To a degree — the approach defines stakeholders Principle considered — as per section 3.2.1, the Principle not considered — the approach
Objectives for as “anyone who believes they have a stake/is EERA approach recognises that there are two provides a technical, GIS-led solution for
ecosystem thought to have a stake in a specific issue or ways in which environmental limits can be developing “robust and defensible green network
management activity relating to the Kent Thameside Green determined i.e. scientifically or socially policies for LDPs” (GCV Green Network
are a matter Grid (KTGG). They may be individuals or determined. Crucially, the approach recognises Partnership, 2011 p.1). Although, in principle,
of societal representatives of organisations, government that “environmental limits need to be the outputs of the approach will inform proposals
choice bodies or groups of interest” (Sheate et al, 2012 predetermined and supported by stakeholders” within MIRs (which will themselves be subject
p.8). In this regard, the approach includes clear and how “the UK’s democratic planning process to extensive public consultation — see section
provision for engagement with a broad range of lends itself well to this approach” (EERA, 2008 3.1.2), the approach itself is designed to be
stakeholders (including local communities and p.12). The EERA project was only able to undertaken by GIS technicians/planners without
other publics) that may facilitate the engage technical stakeholders, presumably due wider input from the public or affected
development of ecosystem management to available resources as per Sheate et al (2012), communities
objectives through societal choice. Despite this, but recognises that stakeholder views in this
the research only engaged with technical regard can provide a proxy for the views of the
stakeholders/agencies so this premise is yet to be wider public. Were the approach to adopted
tested wholesale in spatial planning, it is feasible that
the wider public would be engaged in the
process of determining environmental limits
EsA 10. Unknown — development of the approach to date Principle not considered (either explicitly or To a degree — as described at EsA 4, the
Ecosystem has only considered key practical issues implicitly) approach is designed to identify priority areas for
management concerning identifying the ecosystem services in green network/urban natural environment
should be a given area, linking these to land use/cover enhancement projects. There is strong
decentralised ") using network analysis and mapping ecosystem recognition of the economic practicalities of
to the lowest . services using GIS. The approach has not yet such projects (see ESA 7) and the approach
appropriate informed practical land use/management accounts for this, to a degree, by promoting the
level decision-making (implicit) decentralisation of management
responsibility to developers, landowners and
community groups
EsA 11. - To a degree — see comments above against ESA -I Principle considered — see comments above Principle not considered — see comments above
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Key to scoring

Case study ecosystems approach based urban land use planning frameworks

COZQ&%'P;S THESAURUS EERA Green Network Opportunities Mapping
Considered References: Collingwood Environmental Planning and References: East of England Regional Assembly, 2007; References: GCV Green Network Partnership, 2011;
to a degree Geodata Institute, 2008a; Defra, 2008; Sheate et al, 2012 East of England Regional Assembly, 2008 GCV Strategic Development Planning Authority, 2011
Principle not

considered
Ecosystems o o o

approach S o) o)

principle @ Summary comments/rationale @ Summary comments/rationale @ Summary comments/rationale

Consider all 9. There is a specific opportunity to incorporate a against ESA 9. The approach recognises the against ESA 9

forms of range of relevant information through the importance of engaging stakeholders and the

relevant specific GIS methodology adopted: “ the wider public in the determination of

information assumptions made[when combining spatial data environmental limits. This approach will allow

including sets in the GIS to evaluate proxy ecosystem for the consideration of a range of different

scientific/loca services] and their relative weight would be an information including “local perceptions of the

| knowledge, opportunity for stakeholders to become involved relative value of environmental features or

practice and and tailor the process to locally selected criteria” benefits” (EERA, 2008 p.14)

innovation (Sheate et al, 2012 p.18)

EsA 12. To a degree — see comments above against ESA Principle considered — see comments above Principle not considered — see comments above

Involve all 9and 11 against ESA 9 and 11 against ESA 9

relevant

sectors of

society and

scientific

disciplines
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Appendix 8: Flood control model
step-by-step instructions and
example outputs

Specific technical guidance for undertaking all geoprocessing operations described
in this Appendix is available from the ArcGIS online help resources:

ArcGIS online help for buffer operations:
http://resources.arcgis.com/en/help/main/10.1/index.html#//000800000019000000
[accessed 23/11/13]

ArcGIS online help for clip operations:
http://resources.arcgis.com/en/help/main/10.1/index.html#//000800000004000000
[accessed 23/11/13]

ArcGIS online help — use of the summary statistics tool:
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.htmI#//00080000001z00000
0 [accessed 23/11/13]

Distance is measured using the ArcGIS measurement tool. Further information is
available from ArcGIS online help:
http://help.arcgis.com/en/arcgisexplorer/help/index.html#//015600000002000000
[accessed 23/11/13]

ArcGIS online help — selecting and extracting data:
http://resources.arcgis.com/en/help/main/10.1/index.html#/Selecting and Extracting
data/018p00000005000000/ [accessed 23/11/13]

ArcGIS online help — creating new features:
http://resources.arcgis.com/en/help/main/10.1/index.htmI#//01m700000022000000
[accessed 23/11/13]
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Flood Control Model Step 1: is the catchment subject to significant flood
risk?
Step-by-step instructions and example outputs

Purpose of Step 1: to identify whether the catchment being investigated is subject to significant flood
risk

Supporting technical information in Chapter 4 — relevant 4.1,4.2and 4.3
sections
Supporting technical information in Appendices — relevant 3and 4
Appendices
Related sections in Chapter 7 7.2.1
Key Tasks to undertake in Step 1 of the flood control model
T1.1| e Open ArcMap and add the @ -\ ~
following data, ensuring that all p 1
layers are switched on: A@f i ; -
> waterbodies e |
» catchment area / 5
> 1in 200 year fluvial flood ma
extent foodextent =
> suitable base mapping / / \/J\J DT

e  Further information on data is —_— »
provided at section 2.4.2 : B

e  Are there areas within the
catchment that are likely to flood
under the 1 in 200 year flood .
event? If yes proceed to Task 1.3 N

e It may also be desirable to

quantify the area of the catchment | £j664 control model Step 1, T1.1 — example model
that is likely to flood under the 1 | o,tput: hydrology and fluvial flood extent for the

in 200 year flood event. This Tollcross Burn catchment
could be presented as a

percentage of the total catchment
area. Use data in the attribute
table and the statistics tool in
ArcMap to calculate areas

T1.2 [ ¢ Review the data by eye /
e \;é” Mf

N

T1.3 | ¢ Identify key areas within the
catchment where flooding is
likely to occur under the 1 in 200
year flood event

e  Ensure that the base mapping
layer is active and zoom in to the
affected areas — are there any
receptors that may be impacted by
the flood? See the example figure

-2

opposite
e |fyes proceed to Task 1.4
T1.4 | ¢ Where the 1 in 200 year flood
event is likely to impact receptors, >

make a broad estimation of the
type and number of receptors
affected

 Record this data (see the example | Flood control model Step 1, T1.3 and T1.4 —
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output table below) and move on
to Step 2 of the flood control
model

potential flooding impacts at Tollcross and
Braidfauld under a 1 in 200 year flood event

Flood control model Step 1 example data recording sheet

Catchment Neighbourhood

Residential properties
impacted

Major roads impacted

Tollcross Burn Tollcross Housing at Ardgay St, Wellshot Rd at
Glenalmond St and Shettleston Library and
Amurlee St — circa 80+ Learning Centre
homes affected
Tollcross Rd at junction
with Wellshot Rd
Braidfauld Housing at Potter St and London Rd/A74 at Potter

Rattray St — ¢ 20+ homes
potentially affected

St
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Flood Control Model Step 3: are there significant areas of openspace
within the floodplain?
Step-by-step instructions and example outputs

Purpose of Step 3: to identify the floodplain openspace resource that may be available for the
development of floodplain NFM measures

Supporting technical information in Chapter 4 — relevant

42,43,4.4,4.6and 4.7

sections

Supporting technical information in Appendices — 3and 4
relevant Appendices

Related sections in Chapter 7 7.2.3

Key Tasks to undertake in Step 3 of the flood control model
Note: Step 3 should use the same ArcGIS project (.mxd file) set-up at Step 1

T3.1

Buffer the waterbodies layer
Detailed geoprocessing
instructions for carrying out
buffering operations in ArcGIS
are available from ArcGIS online
help. Guidance on selecting an
appropriate width for the
floodplain cross-section for use in
the buffer operation is provided
below

T3.2

Add the PANG5 openspace data to
ArcMap

Clip the PANG5 openspace data to
the output from the waterbodies
buffer operation (i.e. the modelled
approximation of the floodplain
generated through Task 3.1)
Detailed geoprocessing
instructions for carrying out clip
operations are available from
ArcGIS online help

% \
o \

sl ~ Tollcross B.urn K\
floodplain

-z

1:42,000

Flood control model Step 3, T3.1 and T3.2 —
modelled approximation of the floodplain and
identification of the floodplain openspace resource

T3.3

Calculate the cumulative area of
floodplain openspace falling
within the study catchment — this
is the output from the Task 3.2
clip operation

Instructions for how this
calculation can be carried out in
ArcGIS are available from
ArcGIS online help

Tollcross Burn floodplain openspace metrics
Area of catchment (ha) Total area of floodplain
openspace (ha)

Percentage of catchment

area comprised of

floodplain openspace (%)

2621.5 133.6

51

T3.4

Calculate the percentage area of
the study catchment that is
comprised of floodplain
openspace

Where this is greater than or equal
to 2%, the practitioner may wish
to progress to Step 4

Flood control model Step 3, T3.1 and T3.2 —

floodplain openspace metrics

Flood control model Step 3 — guidance on the selection of buffer parameters for

T3.1
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Context

Step 3 of the flood control model is predicated on modelling an approximation of the functional
floodplain within the study catchment of interest. The Scottish Government (2010) and SEPA (2012)
suggest that in SFRA for land use/development planning purposes, the functional floodplain can be
considered as synonymous with the area encompassed by the 0.5% probability (1 in 200 year return
period) fluvial flood extent data supplied by SEPA. However this data does not give a true
representation of the functional floodplain as it takes account of existing flood defences,
anthropogenic geomorphological changes etc in its delineation of flood extent — i.e. stretches of the
watercourse that are not currently connected with their floodplain and therefore do not have a natural
flooding regime in place. The flood control model developed in this research is intended to provide
urban planners with a forward looking planning tool that can support the development of visionary
land use plans and projects. Accordingly, Step 3 takes a much broader view of the potential functional
floodplain, thereby supporting the identification of restoration options that may be viable in the future
(e.g. where land use change is proposed). Further information on FRM planning and approaches is
provided at section 2.5

e Step 3 Task 3.1 models an approximation ya - N
of the floodplain is by buffering the study A ; N
watercourse in the GIS - D AU ¥

e The dimension for the buffering S~ '{?’f r_/l\i\s\)‘:;q{)ffiﬁ/.

. . . { J _ — o -

operation (i.e. half the floodplain cross- A Tmaw g f\\.‘_
section) is ascertained by measuring the o ST/ Mevdextent \\
distance (at right angles to the . T S U
watercourse) of the width of the fluvial -~ ST T
flood risk area at its greatest extent. This . re i B
exercise uses SEPA’s 0.5% probability ) = N
fluvial flood extent data as indicated on — ('h"/f g-'/"?’“f
the figure opposite ' Tollross Burn Y g

e  This measurement is then inputted to the e //@\ N
buffering operation in the GIS when N ) N

modelling the floodplain

1:42,000

¢ Inadopting the measurement protocol Yo
outlined above, the floodplain modelling | Ascertaining the buffer parameter used at Step 3
exercise at T3.1 will always yield a T3.1 — identifying the width of the fluvial flood risk
uniform floodplain. This is considered area at its greatest extent in the study catchment
appropriate given the objective of the
exercise — see section 5.1.3 for further
information
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Flood Control Model Step 4: is the watercourse subject to morphology
pressures?
Step-by-step instructions and example outputs

Purpose of Step 4: to identify whether the watercourse being investigated is subject to the types of
morphology pressure that lend themselves to being addressed as part of land use/management based

NFM schemes

Supporting technical information in Chapter 4 — relevant 4.4 and 4.5
sections

Supporting technical information in Appendices — relevant | 3 and 4
Appendices

Related sections in Chapter 7 7.2.4

Key Tasks to undertake in Step 4 of the flood control model
Note: Step 4 should use the same ArcGIS project (.mxd file) set-up at Step 1

T4.1

Add the morphology pressures
data to ArcMap, extracting
culvert and realignment pressures
if necessary. Guidance on data
extraction using the select tool in
ArcGIS is available from ArcGIS
online help

Overlay the pressures data with
the floodplain openspace layer
(output from Step 3) and identify
(by eye) areas where the two
features are coincidental

Low/high
impact
realignment
(green)

Tollcross Burn

floodplain
Floodplain
openspace
Box culverts

A ‘ (black) ,

1:42,000

Flood control model Step 4, T4.1 — coincidental

T4.2

Zoom in to a site of interest where
floodplain openspace and
morphology pressures are
coincidental

Add the historic (1860s) viewing
raster to ArcMap

Identify the historic route of the
watercourse and digitise the
historic route. Guidance on
digitising in ArcGIS is available
from ArcGIS online help

The figure opposite clearly shows
how there is a marked difference
between the historic route of the
watercourse (shown in purple)
and the culverted route of the
watercourse (shown in blue)

floodplain openspace and morphology pressures

o S N

3l 4 i ! 28 T
o i RSSO | t

'msn}m route of
Tollcross Burn -
S0 digitised

Flood control model S;cep 4 T4.2 — digitising
historic /pre-modification route of the study
watercourse
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T4.3 | ¢  Turn off the historic (1860s)
viewing raster and turn on
modern base mapping including
the 1:10000 viewing raster and
OS MasterMap, ensuring that the
newly digitised historic
watercourse layer is on
e View the site at a range of scales
using different modern base
mapping and identify constraints
to restoring the historic route of
the watercourse:
» housing
> other buildings
» roads infrastructure
e Ideally, the watercourse will be
restored as close as possible to its
original route though modern
constraints may predicate this
e This type of restoration approach
can help water environment
stakeholders access funding for
project delivery, such as national
funding programmes under the
Water Framework Directive

B s S s
B SO e T

Potemid‘l = = comstraint —roads,
constriint — 2 Inp'aslru:lu|~e
| housing T—— =% 1, / L
NN e Potential
3> " constraint
Ol s housing
- AR =5 ——n

Historie.route of~

Tollcross Burn -
digitised 272

1 Floodplain
opénspace
. (Sandyhills

e P x Park)

Route of Tollcross £
Burn culvert at

o 2 = ;
& o® Sandyhills Park

Flood control model Step 4, T4.3 — identifying
possible constraints to river restoration

g

T4.4 | « Based on the constraints
identified at Task 4.3, digitise the
approximate area within the study
site that may be available for
floodplain reinstatement. Note:
this is a broad estimate at this
stage and doesn’t account for
other constraints such and
topography or underground
infrastructure
e Make a note of the potential area
of the reinstated floodplain (i.e.
the area of the newly digitised
polygon — see bullet point above)
and the key constraints to
floodplain reinstatement
e Key constraints to river
restoration at the site in the figure
opposite are summarised at the
end of this table

S

WHQ

5 s | Potential area
= L available for
s floodplain

nl-n;talbmt 9

i

jme?

S

Flood control model Step 4, T4.4 — digitising the
potential reinstated floodplain based on T4.3
constraints

Note

Tasks 4.2 — 4.4 should be repeated for all sites identified at Task 4.1 where culvert and
realignment pressures are coincidental with areas of floodplain openspace. All potential
floodplain reinstatement areas identified at T4.4 should be digitised. These are all potential
NFM priority areas in their own right and could feasibly be used in the integration of spatial
model outputs to identify ecosystem service priority areas (see Chapters 4 and 6)

The wider multiple benefits of river restoration

e River restoration is one of several land use/management based NFM measures considered in this
research. Although restoring a watercourse to its original route will support a range of FRM
benefits (e.g. reinstating a meander will increase the overall length of the watercourse,
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contributing to hydraulic improvements and helping to delay downstream flood flows etc),
restoration as part of a wider land use/management based strategy has the potential to enhance

FRM benefit whilst also delivering wider multiple benefits

e A key example is the introduction and/or restoration of floodplain woodland as described at
section 2.4.5. That said, floodplain measures (such as woodland establishment) can require a
sizeable river corridor to provide the physical space necessary for the establishment of
sufficiently sized woodland blocks to positively influence downstream flood flows. This is in
addition to other local factors such as topography that can influence the magnitude of the
woodland’s flood storage effect and therefore the viability of the scheme (see Appendix 3)

e Assuch, the constraints analysis undertaken during T4.3 should also consider how any identified
housing and infrastructure constraints may impact the dimensions (including the cross-section) of
any reinstated functional floodplain

Summary of constraints and details of potential floodplain reinstatement

opportunities

Site details

Housing and other built
environment constraints

Transport infrastructure
constraints

e Catchment: Tollcross
Burn

e Neighbourhood:
Sandyhills

e  Site: Sandyhills Park

e Potential floodplain
reinstatement area:
1.54ha

Housing at Lochay Street
(approximately 20 homes)

Ardgay Street (also a bus route)

Housing at Ardgay Street
(approximately 28 homes)

Balbeggie Street (also a bus route)
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Flood Control Model Step 5: is there potential for significant areas of
floodplain woodland and wetland?
Step-by-step instructions and example outputs

Purpose of Step 5: to identify whether existing or potential areas of floodplain woodland and wetland
within the study catchment are significant in NFM terms

Supporting technical information in Chapter 4 — relevant 4.4,4.6and 4.7
sections

Supporting technical information in Appendices — relevant | 3 and 4
Appendices

Related sections in Chapter 7 7.25

Key Tasks to undertake in Step 5 of the flood control model
Note: Step 5 should use the same ArcGIS project (.mxd file) set-up at Step 1

T5.1 | ¢ Add the woodland and wetland
habitat patches, low and high
dispersal habitat networks and
woodland and wetland
opportunities data to ArcMap

-—) 2

e This is six data sets in total. Existing
Further information on these Tatehes ety -
data sets can be found at section Existing low U

dispersal woodland
2 4 2 habitat network

(dark green)

T5.2 | ¢ Clip the six data sets listed at
T5.1 to the output from the .
waterbodies buffer operation : v&
(i.e. the modelled YA
approximation of the floodplain
generated through Task 3.1)

e Detailed geoprocessing

instructions for carrying out clip .
operations are available from Flood control model Step 5, T5.2 — floodplain

ArcGIS online help woodland habitat patches and habitat networks

T5.3 | ¢  Using the Microsoft Excel
model developed through this

research (example output Total area of existing woodland habitat patches (m2) 122991.32
H Total area of existing woodland patches (ha) 12.30
opposite), calculate the
N R R Total area of existing woodland habitat network (m2) 361423.32
followi ng five habitat metrics Total area of existing woodland network (ha)
for both f|00dp| ain woodland Area potential avaible for woodland epansion (ha) N
Percentage of catchment area currently comprised of woodland (%,
and wetland and record (eg see Percentage of catchment area potentially comprised of woodland (%4
Table 53) Total area of existing wetland habitat patches (m2) 16800.00
H . Total area of existing wetland patches (ha) 1.68
> Met_rlc L tOtaI area Of Total area of existing wetland habitat network (m2) 59800.00
habitat patches (ha) Total area of existing wetland network (ha)

» Metric 2: total area of Area potentially available for wetland expansion (ha)
habi ks (h Percentage of catchment area currently comprised of wetland (%)
al It?t networ S ( a) [Percentage of catchment area potentially comprised of wetland (%) | 0.23]
> Metric 3: potential area Flood control model Step 5, T5.3 — calculating

available for habitat floodplain habitat metrics
expansion (ha)

» Metric 4: percentage of
catchment area currently
comprised of habitat (%)

» Metric 5: percentage of
catchment area potentially
comprised of habitat (%)
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Note | As part of Task 5.3, practitioners should analyse output habitat metrics to help form a view of
the viability of floodplain wetland and woodland as ‘stand-alone’ NFM strategies within the
catchment under investigation (i.e. with reference to the quantified thresholds discussed at
section 2.4.5). This analysis could also include consideration of sub-optimal habitat expansion
sites as an alternative scenario when calculating habitat metrics (see below for further
information). Alternatively, where they are not viable as stand-alone NFM strategies,
floodplain woodland/wetland could be considered as part of an integrated strategy
incorporating other land use/management based NFM measures

The rationale for habitat metric calculations at flood control model Step 5, T5.3

e Inessence, Metric 3 is equivalent to all areas of land that are encompassed by a habitat network
but where land cover is not currently classified as habitat. Habitat networks are the areas of land
adjacent to habitat patches where existing land use is such that species are able to move freely
within this surrounding area (see section 2.6 for further information)

e Accordingly, it is reasonable to consider areas of land within existing habitat networks as optimal
sites for habitat establishment. Within the context of the flood control model therefore, these
areas of land constitute potential floodplain wetland and woodland expansion areas, hence why
Metric 3 is obtained by subtracting Metric 1 from Metric 2

e The ecological potential of areas of land within habitat networks is also a feature of the habitat
opportunities data sets. As is evident from an analysis of Figures 5.7 and 5.8, areas of high
ecological potential identified on Figure 5.8 are frequently clustered around existing habitat
patches and habitat networks on Figure 5.7. This issue is an important issue when considering
sub-optimal habitat expansion sites as part of floodplain woodland wetland NFM strategies (see
below)

Identifying sub-optimal habitat expansion sites for floodplain habitat NFM
strategies

The approach presented through Tasks 5.2 and 5.3 is geared towards the identification of optimal
habitat expansion sites (and associated habitat metrics) where ecological potential is particularly high
i.e. areas of land within low dispersal habitat networks. Given this, there is also potential to explore
habitat expansion opportunities at more marginal sites, particularly where floodplain woodland is
being pursued as one element of an integrated NFM strategy (see sections 5.1.5 and 5.1.8)

An overlay of the woodland habitat N
opportunities data (see Figure 5.8) and the ]
existing woodland habitat patches/networks
data (see Figure 5.7) from the Tollcross
Burn case study shows how significant areas
of land with good ecological potential to

support woodland expansion (i.e. data poteutial met catachiomni
represented on Figure 5.8) do not coincide Ttk ehteg LAl netmork N o

A ‘&,\)
with existing woodland habitat patches or V i
their habitat networks. This indicated on the ‘ .
figure opposite f ——
<o

Overlay of woodland habitat opportunities data (see
Figure 5.8) and existing woodland habitat patches
and networks data (see Figure 5.7)
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Approximations of these outlying areas can
be digitised in the GIS (see figure opposite)
and a new metric calculated to give an
indication of the total area of potential
woodland habitat within the catchment
when more marginal, sub-optimal sites are
also considered as well. Woodland habitat
metrics in this regard for the Tollcross Burn
catchment are summarised in the table
below. In light of this new calculation, there
would be significant potential for floodplain
woodland as a stand-alone NFM strategy as
the percentage of the catchment area
potentially available for woodland is well
over the 2% threshold

- Z

Digitised area of high ecological
potential not coincidental with
existing habitat network

Sub-optimal sites for floodplain woodland expansion
— digitised to calculate habitat metrics under a sub-
optimal scenario

Tollcross Burn floodplain woodland habitat metrics under sub-optimal scenario

Potential total Potential total area | Potential total area of Percentage of catchment area
area of woodland | of woodland woodland habitat — all sites | potentially comprised of
habitat — optimal | habitat — sub- (ha) woodland — all sites (%)
sites (ha) optimal sites (ha)

36.14 68.59 104.73 3.99
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Flood Control Model Step 6: identify sites where opportunities are

greatest and constraints minimal

Step-by-step instructions and example outputs

Purpose of Step 5: to identify, rank and prioritise floodplain NFM measures that have the potential to
deliver the greatest FRM benefit with the minimum of constraint

Supporting technical information in Chapter 4 — All sections
relevant sections

Supporting technical information in Appendices — 3and 4
relevant Appendices

Related sections in Chapter 7 7.2.6

Key Tasks to undertake in Step 6 of the flood control model
Note: Step 6 should use the same ArcGIS project (.mxd file) set-up at Step 1

T6.1

Review outputs from Task 4.1
(map detailing the route of the
study watercourse, floodplain
openspace and location of
morphology pressures: Fig 5.4)
Identify floodplain openspace
sites that have a direct
hydrological link with the study
watercourse — i.e. sites that the
watercourse flows through in
either a modified or unmodified
state

Review the identified sites and

make a note of their area and

PANG5 land use categorisation

Select appropriate sites for

further consideration in Step 6,

noting whether they are ‘high

cost’ or ‘low cost’. Guidance
and questions to support site
selection are provided below:

» what is the average size of
floodplain openspace sites
within the study
catchment?

> are there a few large
outliers or are all sites of a
similar size?

» in the case of the former, it
may be preferable to select
large outliers only where as
in the latter, it may be
useful to impose a
[arbitrary] size threshold
e.g. select all sites >3ha

> where required, PANG5
land use categorisation can
be used to refine selection
e.g. select sites with a
higher degree of existing

-z

site Area (ba) [PAN65  |Morph.

. site Area (ha) [PANGS  [Morph.
Category |Pressure
Sandyhlls |24 Pak & |Ves
Park sarden_|Culvent

1:42,000

Flood control model Step 6, T6.1 — NFM opportunity
areas identified for the Tollcross Burn catchment
(noting that two ‘low cost’ and two ‘high cost sites’
have been identified)
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‘roughness’ e.g. choosing
park & garden sites over
amenity greenspace sites
for example
Highlight selected sites and key
information on a map (see
opposite). These sites become
the NFM opportunity areas

T6.2

Open the existing ArcGIS
project (.mxd file) that has been
used throughout the flood
control model and turn on the
following layers:
» floodplain openspace
» watercourse restoration
opportunities
> potential floodplain
reinstatement areas
> optimal sites for floodplain
woodland and wetland
expansion
Zoom in to NFM opportunity
areas identified at Task 6.1 and
make a note of NFM measures
that may be available e.g. is
there scope for significant
floodplain reinstatement at
‘high cost’ sites? Are there
existing habitat networks and is
there the ecological potential to
expand these?
Note: At this scale of analysis
(i.e. catchment-wide scoping) it
is assumed that some degree of
engineering/bunding will be
possible for all sites scoped in at
Task 6.1. This measure should
be scoped in for every NFM
opportunity area

-2

NFM opportunity

area No.3 — A"/
> A 'S !9"

NFM opportunity
area No.4

NFM opportunity
areaNo.1

../

NFM opportunity
area No.2

Flood control model Step 6, T6.2 — identification of
potential NFM measures and combinations of
measures for each scoped in NFM opportunity area

T6.3

Review analysis undertaken at
Task 6.2

Using a table such as that
shown opposite (and at Table
5.7), collate a schedule of all
potential NFM measures
available at each NFM
opportunity area

A complete schedule of possible
measures (and combinations of
measures) at ‘high cost’ and
‘low cost’ sites is provided at
Table 5.8

Schedules of potential NFM
measures identified for NFM
opportunity areas No.3 and

Site details Potential NFM measures available

1. Leave the site as is and zone in LDP as flood
storage area

2. Engineering/bunding of the site to increase
flood storage capacity

PANGS category|Amenity greenspace |3 BXpansion of floodplain woodland

4. Expansion of floodplain wetland

5. Fully integrated scheme incorporating LDP
zoning, engineering/bunding of the site,
floodplain woodland expansion and floodplain
wetland expansion

Site | Baillieston Rd.

NFM Opportunity No.|3

Area (ha)(32

High/low cost|Low cost

1. Leave the site as is and zone in LDP as flood

storage area

2. Restore channel and functional floodplain

and reconnect watercourse with floodplain

3. Channel/functional floodplain restoration +
ing/bunding of the site

4. Channel/functional floodplain restoration +

floodplain woodland expansion

5. Fully integrated scheme incorporating

channel/floodplain restoration, engineering/

bunding of the site and floodplain woodland

expansion

Site |Denmilne Road

NFM Opportunity No.|4

PANG5 category|Semi-natural
greenspace
Area (ha)|32.5

High/low cost|High cost
(channelised)

Flood control model Step 6, T6.3 — example schedules
of potential NFM measures
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No.4 from the Tollcross Burn
catchment case study are shown
opposite

Ensure that identified NFM
measures are ranked on the
basis of FRM benefit (see Table
5.8 for guidance)

T6.4

Review the Microsoft Excel
based MCA models for both
‘high cost’ and ‘low cost’ sites
(available electronically on
request)

Where required, liaise with
stakeholders as appropriate (e.g.
technical colleagues, members
of the public in affected areas
etc) and agree cost/performance
scores for each measure and
MCA weightings

Note: multiple MCA scenarios
can be run to explore different
issues, drivers and decision-
making contexts. Scenarios can
be developed using different
weights and cost/performance
scores

For each NFM opportunity area
identified (see Task 6.1), review
the schedule of potential NFM
measures from Task 6.3

For each NFM opportunity area,
rank the potential NFM
measures on the basis of their
MCA score. The higher the
MCA score, the higher the FRM
sustainability of the NFM
measure(s) under that particular
configuration of
cost/performance scores and
weightings. Note that this
ranking exercise should be
undertaken for each
weighting/scoring scenario run
in the MCA evaluation process
Review the outputs of the MCA
evaluation process. Where
required, discuss outputs with
stakeholders and agree which of
the potential NFM measures or
combinations of measures will
be taken forward for further
analysis in Steps 7 and 8

Note: the MCA evaluation
process described above is
intended for use as a decision-

1. Likely number/total

area of potential sites

Manning's n/FRM benefi

2. Likely cost of
intervention
3. Likely impact on

Measure
1. leave site as is and zone in LDP as
a flood storage area
2. engineering/bunding of the site

i

3. floodplain woodland expansion

4. floodplain wetland expansion

5. fully integrated NFM scheme

Flood control model Step 6, T6.4 — example MCA
output for ‘low cost’ site weighted for FRM benefit

=
= 2
<
s 8 .
S =
= v °s
83 |© S
E e k7] a L
S @ o < g <
o ‘6 o 9 =
>a [>E >
D = T © < S
X © x 2 X c
a3 4J g a5
Measure - 3 o S @ =
1. leave site as is and zone in LDP as
-0.24 0.06 -0.08
a flood storage area

2. engineering/bunding of the site

3. floodplain woodland expansion

4. floodplain wetland expansion

5. fully integrated natural FRM
scheme

Flood control model Step 6, T6.4 — example MCA
output for ‘low cost’ site weighted for cost
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support tool only for this
particular step in the flood
control model. Practitioners
may just as well choose to
progress to Steps 7 and 8 with
different measures on the basis
of other factors

Additional information on the MCA approach

The purpose of the MCA is to help practitioners using the flood control model prioritise NFM
measures (or combinations of measures) to take forward to Steps 7 and 8. It is not intended to be
an exhaustive approach, rather it is an additional element to aid decision-making

Each measure considered in the MCA is assigned a qualitative performance score against criteria
1 (likely number or area of sites) and 3 (FRM benefit). Quantified performance scores used in the
MCA are always positive. The range of qualitative and quantitative performance scores used in
the MCA are as follows: Low (0.20), Low-Med (0.40), Med (0.60), Med-High (0.85) and High
(1.0)

Measures are also assigned a qualitative cost score against criterion 2 (likely cost of intervention).
Quantified cost scores used in the MCA are always negative. The range of qualitative and
quantitative cost scores used in the MCA are as follows: Low (-0.4), Med (-0.75) and High (-1.0).
At ‘high cost’ sites, the cost score is always High (-1.0)

The MCA weights cost and performance scores before summing to give an overall MCA score
for each measure (or combinations of measure) considered. Weightings and the cost/performance
scores themselves can be adjusted by the practitioner, allowing for different preferences to be
expressed for different contexts. For example, if the flood control model was being used to inform
the prioritisation of actions in a Surface Water Management Plan (SWMP) in a high risk urban
catchment, it may be appropriate to adjust the MCA weighting to put greater emphasis on FRM
benefit and less on cost

In addition to the MCA, practitioners may wish to undertake further prioritisation of potential
NFM measures on the basis of metrics produced at Steps 4 and 5 of the flood control model. For
example, measures at ‘high cost’ sites (i.e. measures that will always require a degree of channel
and floodplain restoration) can be prioritised where restoration would contribute to the greatest
potential increase in watercourse length and/or the greatest potential increase in area of reinstated
floodplain (see sections 2.4.4 and 5.1.4). Equally, measures involving floodplain woodland and/or
wetland expansion (see sections 2.4.5, 2.4.6 and 5.1.5) could be prioritised where the area
potentially available for habitat expansion is greatest. Integrated projects could consider a range
of different metrics. The full range of metrics produced through Steps 3, 4 and 5 of the flood
control model are outlined at Tables 5.3, 5.4 and 5.6 respectively
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Flood Control Model Step 7: Review topographical data to identify

further constraints and viability of measures
Step-by-step instructions and example outputs

Purpose of Step 7: to estimate the gradient of the floodplain cross-section at key locations within
NFM opportunity areas in order to identify further constraints on the development of NFM schemes

Supporting technical information in Chapter 4 — 4.4 and 4.6
relevant sections

Supporting technical information in Appendices — 3and 4
relevant Appendices

Related sections in Chapter 7 7.2.7

Key Tasks to undertake in Step 7 of the flood control model
Note: Step 7 should use the same ArcGIS project (.mxd file) set-up at Step 1

T7.1

contour data available
» waterbodies (primary data set)

» floodplain reinstatement area

change in elevation

sites

» watercourse restoration opportunities

e  Open the existing ArcGIS project (.mxd file) and add the most detailed topographical

e Ensure that the following additional layers are switched on:

e Zoom in to an NFM opportunity area of interest and review floodplain topography
¢ Identify two to three floodplain sections where the gradient is steepest. Note: steep
gradients occur where topographical contours are closest together i.e. the greatest rate of

e The floodplain sections identified through this process become the gradient estimation test

e At ‘high cost’ sites, measurements of ‘run’ (distances X and y on the figure below) will
depend on the extent of the proposed floodplain reinstatement area defined at Task 4.4.
‘Run’ measurements (X and y on the figure below) should span the entire width of the
proposed floodplain reinstatement area

Potential restored

Moderate/steep
clrannel

slopeio the
north-west

Maoderate/steep

slopeto the
soutl-east

IZmI

[N
E

£

|
3

I 2.5mz

x12m

4

1 2 4 [3 3 10
N I Metres
Scale 1:200

y12m

Approximate representation of floodplain cross-section at NFM opportunity area No.2 —
Sandyhills Park, test site 2 (looking north-east — see plan below). Note that the four
dimensions shown above (t, X, y and z) are the rise and run data that is obtained from the
GISin Task 7.2 in order to calculate gradient

At ‘low cost’ sites, measurements of ‘run’ should correspond to the dimensions of the
existing floodplain. This can be estimated based on the topographical data or through
consultation with other relevant specialists (e.g. geomorphologists, civil engineers etc)
Practitioners may find it useful to digitise the floodplain cross-section to be measured at
each test site and produce a detailed plan of each site as shown on the figure below. This
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can be a useful aid for Task 7.2 — obtalmng rise’ and run’ data from the GIS

T7.2 | « Zoom in to the gradient estimation test
site
e Using the ArcGIS measure tool,
measure the length of both banks of the
floodplain (i.e. distances x and y on the
figure above). This is the ‘run’ data
e  With reference to the ‘run’ distance
measured above (i.e. distances x and y
on the figure above), count the number
of contours crossed on both banks of
the floodplain and multiply this by the ‘
contour interval of the topographical //R e ¢
data set used. This is the ‘rise’ data (i.e. / // .
distances t and z on the figure gbov_e) » // / /;\ 1\250
e In the case of the figure opposite, five |/ il /11111
contour lines are crossed on the south- | Flood control model Step 7, T7.2 - extractmg
east bank. The data used here is a data from the GIS at NFM opportunity area
LiDAR 0.5m topographical contour No.2 (Sandyhills Park) test site 2
data set so the ‘rise’ is equal to: 5 x 0.5
=2.5m
e Make a note of the ‘run’ and ‘rise” data
and repeat the above for each test site
T7.3 [ e For each test site, input ‘rise’ and ‘run” | SANDYHILLS_TEST_SITE2
data from Task 7.2 to the Microsoft South-East Bank
Excel based gradient estimation model Rise_Difference in elevation (m) 2.5
(available electronically on request) Run_Horizontal distance from the highest |12
e Anexample output from the gradient elevation to the lowest elevation (m)
estimation model is shown opposite Percent slope % 20.8
e For each test site, document ‘rise’, Gradient 5
‘run’ and gradient data using a table
such as that shown at Table 5.9 North-West Bank
Rise_Difference in elevation (m) 2
Run_Horizontal distance from the highest |12
elevation to the lowest elevation (m)
Percent slope % 16.7
Gradient 6
Flood control model Step 7, T7.3 — gradient
estimation model example output for NFM
opportunity area No.2 (Sandyhills Park) test
site 2
T7.4 [ ¢« Review estimated floodplain cross-section gradients at each test site and compare results

Gradient (quantitative)

with the categorisation of potential gradient constraints (see table below)

Gradient (qualitative)

Potential constraint on
floodplain NFM measures

2.5% or 1:40 \Very gentle Less constrained
5% or 1:20 Gentle

10% or 1:10 Moderate

20% or 1.5 Moderate-steep

33% or 1:3 Steep-moderate

50% or 1:2 Steep

100% or 1:1 \ey steep

Categorisation of potential gradient constraint on floodplain NFM measures

Consider the nature of proposed NFM measures (from Task 6.4) and the potential impact
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of floodplain gradients on these measures. For example:
» isita ‘high cost’ or ‘low cost’ site?
»  will earthworks be required regardless i.e. as part of channel/floodplain restoration
works at a ‘high cost’ site?
» might there still be a significant FRM benefit of planting floodplain woodland across
a steep floodplain?
» what are the potential wider benefits of floodplain woodland and wetland expansion?
e Review all available information and liaise with other technical specialists as required
(e.g. geomorphologists, civil engineers etc)
e Inlight of all available information, make a decision as to the appropriateness of the
proposed NFM measures from Task 6.4:
» retain proposed NFM measure(s) as is and proceed to scenario development in Step 8
(option for ‘high cost’ and ‘low cost’ sites)
> revise proposed NFM measure(s) to better account for topographical constraints* and
proceed to scenario development in Step 8 (primarily an option for ‘high cost’ sites)
> reject proposed NFM measure i.e. no further consideration of the site in the flood
control model (option for ‘high cost’ and ‘low cost’ sites)
Based on the above, collate a revised list of proposed NFM measures to carry forward to the
scenario development step of the flood control model (Step 8)

Note: Tasks 7.1 — 7.4 should be repeated for all NFM opportunity areas identified in Step 6. Step 7
tasks have been documented above for NFM opportunity area No.2 at Sandyhills Park. Based on the
analysis described above, Sandyhills Park is considered to be relatively unconstrained in terms of
floodplain topography and the NFM measure proposed at Step 6.4 has been carried forward to Step 8

* This option is only likely to be viable at ‘high cost” sites. It will require practitioners to revisit the
analysis in Step 4 to identify alternative routes for river restoration (Task 4.2) and floodplain
reinstatement areas (Task 4.4). In essence, it may be the case that restoring the floodplain to its
historic/pre-modification route is not viable due to the magnitude of topographical constraints and an
alternative, less steep option must be sought (in order to reduce earthworks costs to ‘viable’ levels —
noting however that this research doesn’t attempt to quantify viability).
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Flood Control Model Step 8: Scenario development
Step-by-step instructions and example outputs

Purpose of Step 8: to translate the proposed outline NFM measures from Steps 6 and 7 into more
detailed scenarios

Supporting technical information in Chapter 4 — All sections
relevant sections

Supporting technical information in Appendices — 3and 4
relevant Appendices

Related sections in Chapter 7 7.2.8

Key Tasks to undertake in Step 8 of the flood control model
Note: Step 8 should use the same ArcGIS project (.mxd file) set-up at Step 1

T8.1

Review key outputs from Steps 6 & 7:
» T6.4 — preferred NFM measure(s)
as identified through MCA
» T7.4—additional
recommendations for preferred
NFM measure(s) that may be
required in order to account for
topographical constraints
Clarify the scope of the proposed NFM
measure(s) and/or suggest alterations,
as required, to account for
topographical constraints as per T7.4
Establish clear and ambitious
objectives that articulate the vision for
the scheme. Example objectives for
NFM opportunity area No.2
(Sandyhills Park) are shown opposite

NFM opportunity area No.2: Sandyhills Park
Proposed scope: channel restoration AND
floodplain woodland expansion

Proposed scheme objectives:

T8.2

Obtain® a high resolution digital
elevation model (DEM) raster for the
site
Add this data to the existing ArcGIS
project (.mxd file) used throughout the
flood control model
Interrogate the DEM to identify fine
scale topographical features:
relic side channels
> relic ponds and other depressions
in the floodplain
» flat areas in the floodplain at a
similar or lower elevation to the
banks of the watercourse
Digitise any identified fine scale
topographical features, ensuring that a
different feature class is used for each
of the three different topographical

1.

Flood control model Step 8, T8:é — example

To open up the culverted section of the
Tollcross Burn running through the
park and restore it to its historic route
To reinstate a functional floodplain

To reconnect the restored burn with its
floodplain wherever possible

To design the channel, banks and
floodplain to provide maximum flood
storage ecosystem services and FRM
benefit

To expand and improve existing
floodplain woodland patches to
provide maximum flood storage
ecosystem services and FRM benefit

DEM raster. The darker the cell the lower the
elevation and vice versa

® Alternatively a DEM can be constructed in the GIS using high resolution LiDAR topographical
contour data (such as that shown at Figure 5.14). See ArcGIS online help — topo to raster (spatial
analyst): http://resources.arcgis.com/en/help/main/10.1/index.htmI#//00920000006s000000 [accessed

30/12/13]
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features listed above. Guidance on
digitising in ArcGIS is available from
ArcGIS online help

T8.3 | ¢ Review topographical contour data for

the site (see T7.1 and T8.2)

o Identify steep sections of the existing
or proposed floodplain

e  With reference to key technical
information (see sections 2.4.4/2.4.6
and Appendices 1 and 2), identify
where essential earthworks (e.g. to
enable complete restoration of the
channel and floodplain at high cost
sites) and non-essential earthworks
(e.g. reducing floodplain gradients in
order to enhance the FRM benefit of
floodplain woodland at low cost sites)
may be required

¢ Highlight recommendations indicating
broad locations for essential and non-
essential earthworks on a plan to
inform T8.4 (see figure opposite)

e  Further guidance on scoping potential
earthworks is provided below

:

Flood cont

NFM opportunity area No.2 where earthworks
may be required in order to realise a desired
floodplain profile

Note: Proposals denoted with the number ‘1’
are likely to be essential due to floodplain
gradients at these locations. Proposals denoted
with the number 2’ are desirable but non-
essential.

T84 | e

desired floodplain profile

» creation of spillways

R A=
L=

K, 5 s T

Review digitised fine scale floodplain topographical features from T8.2
e Review recommendations for essential and non-essential earthworks from T8.3
o Identify areas where major and minor scale earthworks may be required to realise the

o Identify areas where land engineering works may be required to exploit fine scale
floodplain topographical features in order to enhance flood storage ecosystem services:

» creation of floodplain scrapes on areas of flat ground
» creation of interconnected floodplain wetland mosaics
» engineering of relic side channels to increase flood storage

e Mark all of the above on an outline geomorphology and land engineering strategy plan,
showing the broad locations and extent of potential earthworks and other key features (see
the figure opposite and explanatory key below)

' g Flood control model Step 8, T8.4 —

. outline geomorphology and land
engineering strategy plan (see
explanatory key below for further
information)

“ NOT TQ.SCALE
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Tollcross Burn Catchment NFM Opportunity Area No.2 (Sandyhills Park) - Outline Geomorphology & Land
Engineering Strategy Plan: Explanatory Key
Strategy  [Strategy Details
planitem |theme

i Baseline Route of existing culvert
A Strategy The primary function of this zone is FRM. Flood storage is provided by the proposed two
zone stage channel and floodplain woodland expansion/enhancement. The provision of safe

access to the water at this location is less critical and the existing topography is less
constrained. Accordingly, bank and floodplain gradients can be steeper and earthworks are
likely to be less onerous

B Strategy The primary functions of this zone are split equally between FRM and access/amenity.
zone Flood storage is provided primarily by the two stage channel. Accordingly, bank and
floodplain gradients will be as shallow as possible (to facilitate safe access to the water for
leisure, educational purposes etc) and earthworks are likely to be onerous. The shallow
gradient of the floodplain at this location will ensure that the floodplain is rapidly inundated
during high flows, providing FRM benefit

C Strategy The primary function of this zone is FRM and access to the water is a low priority. Flood
zone storage is provided primarily by the proposed floodplain woodland
expansion/enhancement. This zone has the least constrained topography and earthworks
are likely to be less onerous

1 Proposed Approximate location of reinstated main channel
intervention

2 Proposed Potential to increase the limit of the proposed new floodplain if desirable (on the basis of
intervention |housing and road/path infrastructure constraints only)

3 Proposed Potential location of spillway to feed the floodplain scrape at Proposed Intervention 4
intervention

4 Proposed Floodplain scrape at area of flat ground to the north-east of proposed reinstated channel.

intervention |The scrape should be designed to provide flood storage as well as biodiversity/habitat and
amenity benefits

5 Proposed Major earthworks to create desired profile and section of the reinstated channel and
intervention |floodplain at this location. To include a meandering and relatively wide and shallow main
channel (where water will be located during low flows) and wet berm/wetland areas
associated with the main channel that will be progressively inundated during medium-high
flows. The second stage channel/wet bermarea should be designed to accommodate high
flows under the 200 year return period event + climate change

6 Proposed Less major earthworks to create the desired profile and section of the reinstated channel
intervention |and floodplain at this location. To adopt the same design protocols as Proposed
Intervention 5 though the gradient of the channel and floodplain can be steeper at this
location as safe access is less critical

T8.5 [ ¢ Review key outputs from Steps 1, 4, 5 and 6, ensuring that the following layers are

switched on:

» T1.1—waterbodies and fluvial flood extent

» T4.4 —potential floodplain reinstatement area

» T5.2 —floodplain woodland/wetland habitat patches and habitat networks
»  Step 5 — sub-optimal sites for habitat expansion (where relevant)

e Revisit Step 6 (see T6.4 in particular) and identify all NFM opportunity areas where
floodplain woodland/wetland enhancement has been identified as a potentially viable
NFM strategy

e With reference to the above, undertake the following:

» at ‘low cost’ sites where floodplain woodland and/or wetland enhancement is viable
(see T6.4), identify where habitat patches/networks are located within the existing
floodplain (i.e. the area encompassed by the fluvial flood extent data — see T1.1)

» at ‘high cost’ sites where floodplain woodland and/or wetland enhancement is viable
(see T6.4), identify where habitat patches/networks are located within the potential
floodplain (i.e. the potential floodplain reinstatement area — see T4.4)

e Consolidation of existing habitat patches for FRM benefit: with reference to section
4.6, Chapter 5 and Appendices 4, 5 and 6, develop recommendations for consolidating
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existing floodplain habitat patches to improve FRM performance. At this stage, it may be

desirable to refer to any existing management plans® to inform the development of

recommendations, for example:

» s the existing species mix suitable for FRM (e.g. are tree species water tolerant)?

» what is the current/proposed stocking for woodland and could this reasonably be
increased to enhance flood storage ecosystem services and FRM benefit?

» how is dead wood and the understorey managed and could this reasonably be altered
to enhance flood storage ecosystem services and FRM benefit?

» what management (if any) is in place to protect existing wetland (e.g. regular
vegetation removal to prevent natural succession)?

Creation of new habitat for FRM benefit: once recommendations have been developed

to improve the FRM performance of existing habitat patches, it may be appropriate and/or

desirable to consider options for creating new floodplain habitat features. The creation of
new habitat poses a significant opportunity to integrate key FRM design principles from
the outset, thus ensuring that flood storage ecosystem services and FRM benefit is
maximised:

» recommendations for the creation of new floodplain habitat patches should be
developed with reference to section 4.6, Chapter 5 and Appendices 4, 5 and 6

» consider the topography of the existing (low cost sites — see Step 7 and T8.2) or
proposed (high cost sites — see Step 7 and T8.4) floodplain in the design of new
habitat features

> habitat creation should ideally focus on sites within existing habitat networks (i.e.
sites with good ecological connectivity)

» suitable sites for habitat creation may also be available outwith existing habitat
networks yet within areas of land that have good ecological potential for habitat
creation (see the Step 5 guidance above on identifying sub-optimal sites for habitat
expansion)

> ensure that the spatial configuration of proposed new habitat features is designed to
improve connectivity with surrounding habitat networks, including those that are
adjacent to the floodplain in the wider landscape

Based on the above, develop an outline strategy plan for proposed floodplain woodland

and wetland habitat enhancement and/or creation (see example below)

Flood control model Step 8,
T8.5 — outline floodplain
woodland strategy plan (see
explanatory key below for
further information)

T/ [N =2 15
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Tollcross Burn Catchment NFM Opportunity Area No.2 (Sandyhills Park) - Outline Floodplain Woodland Strategy

Pr Plan: Explanatory Key
It|Strategy  [Strategy Details
e[planitem |theme
ti i Baseline Extent of existing floodplain woodland habitat network (dark green)
N ii Baseline Extent of existing floodplain woodland habitat patches (yellow)
1 iii Baseline Route of existing culvert
p AandC [Strategy Primary function of floodplain woodland intervention within these zones is to deliver FRM
c zone benefit by increasing values of Manning's n for the bank and floodplain, promoting out of

bank flows and increasing the extent and depth of flooding across the floodplain. Zone A is
secondary to Zone Cin this regard as it is more constrained by topography (the floodplain
profile is generally steeper). Floodplain profiling within Zone Cis likely to be less onerous
hence the rationale for focusing the FRM function of floodplain woodland at this location.
Proposed stocking density in Zone A is lower than Zone C and planting strategy should be
designed to deliver amenity/landscape benefit as well as the primary FRM benefit

B Strategy The primary function of floodplain woodland intervention within these zones is to deliver
zone landscape and amenity benefit. Any FRM benefit is secondary
1 Proposed Interplanting and high density restocking of existing woodland habitat patches to maximise

intervention |FRM benefit of existing woodland blocks. All new planting should use tree species
appropriate to the wet conditions such as trees fromthe Salix (willow) and Betula (birch)
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T8.6

e Review outputs from T8.4 and T8.5
e Consider how essential earthworks at ‘high cost’ sites (see T8.3 and T8.4) may constrain
or support other NFM measures:

» which stretches of the channel/floodplain are likely to retain steep gradients?

» where will newly created stretches of shallow channel/floodplain gradient be located?

» marry-up habitat focussed NFM measures with suitable gradients, for example:

o wetland features, floodplain scrapes etc will require shallow gradients
o woodland features will perform better for FRM on shallower sites but can
also planted on steeper sites, delivering wider benefits including landscape,
amenity and biodiversity/habitat network
e Consider each individual strategy plan from T8.4 and T8.5 in turn to identify potential
synergies (practitioners may wish to use a matrix based approach to explore compatibility
between each measure). For example:

» stocking density and silvicultural treatment (e.g. mounding) for floodplain woodland
can be manipulated across the site to provide different Manning’s n/roughness values
for different parts of the site

> habitat based NFM measures can be used to support land engineering measures (e.g.
floodplain scrapes) by manipulating (e.g. slowing flows and increasing flood depth)
and diverting the flow to flood storage areas

e Based on the analysis above, develop an overall strategy plan for the NFM opportunity
area that integrates the various discrete measures. The plan should include sufficient
information such that relevant specialists (e.g. civil engineers, hydrologists, ecologists,
landscape architects, ecologists etc) can engage in the process and agree a finalised outline
design for testing FRM benefit in an appropriate hydraulic model. An example overall

strategy plan for NFM opportunity area No.2 (Sandyhills Park) is indicated at Figure 5.15

Note: Tasks 8.1 — 8.6 should be repeated for all NFM opportunity areas identified in Step 6. By way
of example, Step 8 tasks have been documented above for NFM opportunity area No.2 (Sandyhills
Park).

Additional information/guidance on scoping potential earthworks

For high cost sites, a degree of earthworks will always be required to create the new channel for
the restored watercourse (see section 2.4.4 and Appendices 1 and 2). Where the watercourse is
being restored to its historic route, the landform associated with the historic floodplain may still
be present. In this case, additional earthworks to engineer the desired floodplain profile may be
minor or not required at all

Where the historic landform has been altered (e.g. through the introduction of made ground),
earthworks may be necessary to achieve the desired floodplain profile. Equally, where other land
uses (e.g. housing, roads infrastructure etc) have encroached onto land formerly occupied by the
floodplain, it will be necessary to realign the reinstated floodplain to account for these constraints.
In this case, the configuration of the reinstated floodplain may be such that it is ‘pushed’ onto an
area of high/steep ground, meaning that some degree of earthworks will be required to achieve
the desired floodplain profile. In instances such as this, the costs of the earthworks must be
balanced against the FRM and wider multiple benefits of the NFM scheme

Essential earthworks at high cost sites must take cognisance of the dimensions of the potentially
available floodplain reinstatement area identified at Step 4, Task 4.4. For example, the available
area may be constrained and of insufficient width such that suitably gentle floodplain, bank and
channel gradients cannot be achieved, potentially negating/reducing FRM benefit and reducing
the overall viability of the scheme — see section 2.4.4 and Appendices 1 and 2
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Appendix 9: Hydrological cycle
model step-by-step instructions
and example outputs

Specific technical guidance for undertaking all geoprocessing operations described
in this Appendix is available from the ArcGIS online help resources:

ArcGIS online help for buffer operations:
http://resources.arcgis.com/en/help/main/10.1/index.html#//000800000019000000
[accessed 23/11/13]

ArcGIS online help for clip operations:
http://resources.arcgis.com/en/help/main/10.1/index.html#//000800000004000000
[accessed 23/11/13]

ArcGIS online help for simplify line operations:
http://resources.arcgis.com/en/help/main/10.1/index.htmI#//007000000010000000
[accessed 03/05/14]

ArcGIS online help — selecting and extracting data:
http://resources.arcgis.com/en/help/main/10.1/index.html#/Selecting and Extracting
data/018p00000005000000/ [accessed 23/11/13]

ArcGIS online help for topo to raster operations:
http://resources.arcgis.com/en/help/main/10.1/index.html#//009z0000006s000000
[accessed 03/05/14]

ArcGIS online help for reclassify operations:
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.htmI#//0092000000sr00000
0.htm [accessed 03/05/14]

ArcGIS online help for raster to polygon (conversion) operations:
http://resources.arcgis.com/en/help/main/10.1/index.html#//001200000008000000
[accessed 03/05/14]
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ArcGIS online help for intersect operations:
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00080000000p0000

00 [accessed 03/05/14]
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Hydrological Cycle Model Stage 1: Slope analysis
Geoprocessing instructions and example outputs

Purpose of Stage 1: to characterise the study area in terms of slope and to delineate steep, medium
and gently sloped areas of land in a vector dataset

Supporting technical information in Chapter 4 — relevant sections

4.2,4.3,4.4and 4.7

Related section(s) in Chapter 7

Step 1: buffer study area polygon

tool

Purpose of [For study areas that aren’t defined by

step natural features] to ensure that
opportunities for enhancing ecosystem
processes/intermediate services (i.e.
runoff reduction ecosystem services)
at the peripheries of the study area are
captured in the analysis

ArcGIS BUFFER

geoprocessing | Too] |ocation:

Analysis Tools > Proximity >
BUFFER

class filename
structure

Input feature | Study area polygons
class/classes

Olutput feature | Buffered study area polygons
class

Output feature | [study area name]_[buffer

distance] BUFFER

Parameters

Buffer study area polygons to increase
study area size by between 10 and
30%

Geoprocessing
notes

Purpose of
step

BUFFER: buffer the study area
polygons to the required size using

Reduces the amount of data analysed
in subsequent modelling steps. This is
particularly important for LIiDAR
topographical contour data which is

7.3.1

tool

very rich
ArcGIS CLIP
geoprocessing | Tqo| Jocation:

Analysis Tools > Extract > CLIP

Input feature
class/classes

1. Buffered study area polygons
[output from Step 1]
2. LiDAR topographical contour

class filename
structure

polylines covering the study area | | ) s
Output feature | | iDAR topographical contour ) oK =
class polygons clipped to the study area(s) ||/ (L0 e e T
Output feature | | iDAR_[contour interval]_[study LiDAR topographical contours dataset at 5m

area name]_CLIP

Parameters

N/A

Geoprocessing
notes

CLIP: clip the LiDAR topographical
polyline data (input feature) to the
buffered study area data (clip feature)

intervals clipped to the study area

Step 3: simplify the topographical contours dataset

Purpose of

Reduces the complexity of LiDAR

Simplified LiDAR topographical contours
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step

Geoprocessing instructions and example outputs

topographical polyline data by
removing small fluctuations or
extraneous bends from it while
preserving its essential shape. This
step is necessary for study areas with a
large spatial extent (e.g. whole urban
catchments) due to the volume of data
required to be analysed. This step may
not be required for smaller spatial
extents (e.g. masterplan or
neighbourhood areas) or if computer
processing power is sufficient

ArcGIS
geoprocessing
tool

SIMPLIFY LINE

Tool location:

Data Management Tools >
Generalisation > SIMPLIFY LINE

Input feature
class/classes

LiDAR topographical contour
polylines clipped to the study area(s)
[output from Step 2]

Output feature | Simplified LiDAR topographical

class contour polylines clipped to the study
area(s)

Output feature | LiDAR_[contour interval]_[study

class filename
structure

area name]_CLIP_SIMPLIFY

Parameters

o Simplification Algorithm:
POINT_REMOVE

e Maximum Allowable Offset: 10
metres

e  Check for topological errors: NO

o Keep collapsed points: NO:

Geoprocessing
notes

SIMPLIFY LINE: simplify the
LiDAR topographical contour
polylines using the SIMPLIFY LINE
tool and the parameters listed above

Step 4: construct Digital Elevation Model (DEM) raster
Purpose of To create a Digital Elevation Model
step (DEM) raster. The DEM is the starting
point for all subsequent modelling
steps that are influenced by slope
ArcGIS TOPO TO RASTER

geoprocessing
tool

Tool location:
3D Analyst Tools > Raster
Interpolation > TOPO TO RASTER

Input feature
class/classes

Simplified LiDAR topographical
contour polylines clipped to the study
area(s) [output from Step 3]

Output feature | DEM rasters showing the altitude of

class study area(s) surface in metres above
sea level (msl)

Output feature | [study area name]_DEM

class filename
structure

Parameters

e Input feature data: Simplified

dataset at 5m mtervals cllpped to the study
area

DEM raster — light coloured cells represent
higher elevation
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LiDAR topographical contour
polyline data clipped to the study
area(s)

e Input feature data field:
CONTOUR
Input feature data type: Contour
Output cell size: default
Output extent: same as input
feature data (the clipped LiDAR
data)

e Margin in cells: 10

e Drainage enforcement: no enforce

Geoprocessing | TOPO TO RASTER: interpolate a
notes hydrologically correct surface from
the simplified LiDAR topographical
polylines using the TOPO TO
RASTER tool and the parameters

above
Step 5: construct slope raster
Purpose of Based on the input DEM raster, this
step step creates a slope raster. The slope

raster is used to identify steeply sloped
areas of land for use in subsequent
modelling steps

ArcGIS SLOPE

?eolprocessmg Tool location:

o0 3D Analyst Tools > Raster Surface >
Slope

Input feature | DEM surface raster covering the study
class/classes area(s) [output from Step 4]

Output feature | S|ope raster depicting slope angle in
class degrees based on the interpolated

DEM raster ' 3
ggggl#éﬁ;rg [study area name]_SLOPE Slope raster — dark cells represent steeply
structure sloped areas of land
Parameters e Output measurement: degree

e 7 factor: default

Geoprocessing | SLOPE: the SLOPE tool calculates the
notes rate of maximum change in elevation
from each cell to identify slope angle.
Calculate slope angle in the study
area(s) using the SLOPE tool and the
parameters above

Step 6: reclassify slope raster
Purpose of To classify slopes in the study area
step based on their steepness

ArcGIS RECLASSIFY

geolprocess'”g Tool location:

0o Spatial Analyst Tools > Reclass >
Reclassify

Input feature | Slope raster covering the study area(s)
class/classes [output from Step 5]
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Geoprocessing instructions and example outputs

Output feature
class

The input slope raster is reclassified to
give nine different slope classes, from
gentle to steeply sloped, reflecting the
topography of the study area(s). The
reclassification parameter is set to
‘default’ (see below) meaning that the
nine different slope classes reflect
local conditions and are not uniform
across multiple study areas

Output feature
class filename
structure

[study area
name]_SLOPE_RECLASS

Parameters

Reclass field: value
Reclassification: default
Change missing values to
NoData: NO

Reclassified slope ras

e

ter sh

owing discrete

Geoprocessing
notes

RECLASSIFY: use the RECLASSIFY
tool to reclassify the slope raster into
nine slope classes. Use the default
settings as per the parameters above

slope classes — red cells are steep slopes,
yellow cells medium slopes and green cells
gentle slopes

mat

Step 7: convert reclassified slope raster to vector fo
Purpose of To convert the nine raster based slope
step classes in the study area(s) into
polygons. This step facilitates
subsequent stages of the modelling
(catchment analysis and integration
analysis) which are all vector based
ArcGIS RASTER TO POLYGON

geoprocessing
tool

Tool location:
Conversion Tools > From Raster >
Raster to Polygon

Input feature
class/classes

Slope raster covering the study area(s)
reclassified on the basis of slope angle
[output from Step 6]

Output feature
class

Groups of cells from the reclassified
slope raster that share the same slope
attribute are converted to polygons of
the same slope class. The output
dataset is polygons representing a
given slope class

Reclassified slope raster converted to vector
format — red polygons are steep slopes,
orange polygons medium slopes and green
polygons gentle slopes

Output feature
class filename
structure

[study area name]_SLOPE_VECTOR

Parameters

Field: value
o Simplify polygons: YES

Geoprocessing
notes

RASTER TO POLYGON: use the
RASTER TO POLYGON tool to
convert the reclassified slope raster to
polygons of the same slope class

Step 8: extract different classes of slope polygon fro

Purpose of
step

To identify and extract polygons
representing steep, medium and gently
sloped land within the study area(s)

m the vector slope dataset
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Hydrological Cycle Model Stage 1: Slope analysis
Geoprocessing instructions and example outputs

ArcGIS
geoprocessing
tool

SELECT
Tool location:
Analysis Tools > Extract > Select

Input feature
class/classes

Slope polygons covering the study
area(s) classified on the basis of slope
angle [output from Step 7]

Output feature | Discrete polygon feature classes

class representing steep, medium and gently
sloped areas of land within the study
area(s)

Output feature | [study area name]_SLOPE_Steep

class filename
structure

[study area name]_SLOPE_Medium
[study area name] SLOPE_Gentle

Parameters

Use SELECT tool and SQL query
builder to extract steep, medium and
gently sloped polygons. SQL
expressions are as follows:

STEEP slope polygons SQL query:
[GRIDCODE] >=7

MEDIUM slope polygons SQL query:
[GRIDCODE] = 4 OR [GRIDCODE]
=50R [GRIDCODE] =6

GENTLE slope polygons SQL query:
[GRIDCODE] < 4

=
.’-/"‘""" !
,r o
i s =
' -

-

=

Nt
e

Polygéns representing areas of steeply

Geoprocessing
notes

SELECT (steep slopes): extract 'steep’
slope polygons from the slope polygon
data (input feature) using the
expression above

SELECT (medium slopes): extract
'medium’ slope polygons from the
slope polygon data (input feature)
using the expression above

SELECT (gentle slopes): extract
‘gentle’ slope polygons from the slope
polygon data (input feature) using the
expression above

sloped land within the study area

Polygons representing areas of medium
sloped land within the study area
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Hydrological Cycle Model Stage 2: Catchment analysis
Geoprocessing instructions and example outputs

Purpose of Stage 2: to identify the immediate catchment areas of natural and artificial drainage
features and to delineate these areas of land in a vector dataset

Supporting technical information in Chapter 4 — relevant sections

4.2,4.3,4.4and 4.7

Related section(s) in Chapter 7

Step 9: clip OSMM topography polygons to the study area

geoprocessing
tool

Purpose of To reduce the amount of data analysed
step in subsequent modelling steps
ArcGIS

CLIP
Tool location:
Analysis Tools > Extract > CLIP

Input feature
class/classes

1. Buffered study area polygons
[output from Step 1]
2. OSMM topography polygons

Output feature
class

OSMM polygons clipped to the study
area(s)

Output feature
class filename
structure

OSMM_[study area name]_CLIP

Parameters

N/A

Geoprocessing
notes

Purpose of
step

CLIP: clip the OSMM data (input
feature) to the buffered study area data
(clip feature)

To extract only those polygons that
are likely to comprise impermeable
ground. Precipitation falling on or
draining to impermeable land parcels
will end up either in the underground
drainage network or contributing to
pluvial flooding. The immediate
catchment of an impermeable land
parcel may therefore be a candidate
for land use/management and/or storm
water storage intervention to provide
runoff reduction ecosystem services

ArcGIS
geoprocessing
tool

SELECT
Tool location:
Analysis Tools > Extract > Select

Input feature
class/classes

OSMM polygons covering the study
area(s) [output from Step 9]

Output feature
class

Potentially impermeable OSMM
polygons clipped to the study area(s)

Output feature
class filename
structure

OSMM_Impermeable_SELECT

Parameters

Use SELECT tool and SQL query
builder to extract only those polygons
that are likely to be impermeable’
Impermeable polygon SQL query:

7.3.2

(black polygons)

” Further information on OSMM attributes is available ay Edina MasterMap user guide at:
http://edina.ac.uk/mastermap/support/MMUserGuide.shtml [accessed 15/02/14]
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Hydrological Cycle Model Stage 2: Catchment analysis
Geoprocessing instructions and example outputs

[DESCGROUP] = 'Building' OR
[DESCGROUP] = 'Glasshouse' OR
[DESCGROUP] = 'Path' OR
[DESCGROUP] = 'Path; Rail' OR
[DESCGROUP] = 'Rail' OR
[DESCGROUP] = 'Road Or Track'
OR [DESCGROUP] ='Road Or
Track; Structure' OR [DESCGROUP]
= 'Structure'

Geoprocessing
notes

SELECT: extract impermeable ground
polygons from the clipped OSMM
dataset (input feature) using the
expression above

Step 11: identify and extract large impermeable ground polygons only from OSMM topography

tool

layer

Purpose of To extract large impermeable ground

step polygons only. This reduces the
amount of data analysed in subsequent
modelling steps

ArcGIS SELECT

Yeoprocessing | Tool location:

Analysis Tools > Extract > Select

Input feature
class/classes

Potentially impermeable OSMM
polygons clipped to the study area(s)
[output from Step 10]

class filename
structure

Output feature | | arge potentially impermeable

class OSMM poly clipped to the study
area(s)

Output feature | OSMM_Largelmpermeable_SELECT

I T

i

Parameters

Use SELECT tool and SQL query
builder to extract only those
impermeable polygons that are also
large

Example large impermeable polygon
SQL query:

[SHAPE_Area] >= 1000

Geoprocessing
notes

SELECT: extract large polygons from
the impermeable clipped OSMM data
(input feature) using the expression
above.

Note: a 1,000m? threshold is
suggested for the select operation (i.e.
for defining what is meant by a ‘large’
area of impermeable ground). This is a
key parameter where sensitivity
analysis can be used to explore
different outcomes from the modelling

Large OSMM ilmvpermeable g
(black polygons)

round polygons
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Purpose of
step

large areas of impermeable ground)

To identify the immediate catchment
of large impermeable ground polygons
as a proxy for artificial drainage
features. The immediate catchment of
an impermeable land parcel may
therefore be a candidate for land
use/management and/or storm water
storage intervention to provide runoff
reduction ecosystem services

ArcGIS
geoprocessing
tool

BUFFER

Tool location:

Analysis Tools > Proximity >
BUFFER

Input feature
class/classes

Large potentially impermeable
OSMM poly clipped to the study
area(s) [output from Step 11]

Output feature
class

Large OSMM polygons likely to be
impermeable clipped to the study

area(s) and buffered to identify their
potential immediate catchment areas

Output feature
class filename
structure

OSMM_Largelmpermeable_[buffer
distance]_BUFFER

Parameters

Buffer large OSMM polygons to 30m

e Distance: linear unit 30m
e Dissolve type: ALL

Geoprocessing
notes

BUFFER: buffer the large
impermeable OSMM polygons to the
required size using linear units. Where
the volume of input data and/ or
processing power allows, ensure that
all buffers are dissolved. This reduces
the number of output polygons from
the integration analysis.

Note: a 30m buffer is suggested here.
The buffer distance parameter is a key
area where sensitivity analysis can be
used to explore different outcomes
from the modelling

geoprocessing
tool

Purpose of To reduce the amount of data analysed
step in subsequent modelling steps
ArcGIS

CLIP
Tool location:
Analysis Tools > Extract > CLIP

Input feature
class/classes

1. Buffered study area polygons
[output from Step 1]
2. Waterbodies polyline

Output feature
class

All waterbodies clipped to the study

Hydrological Cycle Model Stage 2: Catchment analysis
Geoprocessing instructions and example outputs
Step 12: identify the immediate catchment area of artificial drainage features by proxy (i.e.

® :

J

Large areas of impermeable ground buffered
to 30m (green polygons) — the buffered area
is used as a proxy for the immediate
catchment area of artificial drainage
features to identify locations where land
use/management and/or storm water storage
intervention may be required to enhance
runoff reduction ecosystem services

Step 13: clip waterbodies polyline to the study area
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Hydrological Cycle Model Stage 2: Catchment analysis
Geoprocessing instructions and example outputs

area(s)

Output feature
class filename
structure

Waterbodies_[study area name]_CLIP

Parameters

N/A

Geoprocessing
notes

Purpose of
step

CLIP: clip the waterbodies data (input
feature) to the buffered study area data
(clip feature)

Depending on the nature of the
waterbodies dataset it may be
necessary to extract surface
waterbodies only (i.e. the dataset may
also contain culverts that are not
directly affected by overland flow
based runoff generation mechanisms.
In practice however there is likely to
be a high degree of interaction
between different sources of flooding
and natural and artificial drainage
features — see section 6.2.2)

Step 14: select surface waterbodies only

ArcGIS
geoprocessing
tool

SELECT
Tool location:
Analysis Tools > Extract > Select

Su[’face waterbodi

Input feature
class/classes

Waterbody polylines in the study
area(s) [output from Step 13]

Output feature
class

All surface waterbodies within the
study area(s)

Output feature
class filename
structure

Waterbodies_Surface SELECT

Parameters

Use SELECT tool and SQL query
builder to extract surface waterbodies
only

Surface waterbody SQL query:
[TYPE] ='OPEN WATERCOURSE'

Geoprocessing
notes

Purpose of
step

SELECT: extract surface waterbody
polylines from the waterbodies data
(input feature) using the expression
above.

Note: the expression above has been
developed for use with Glasgow City
Council’s waterbodies dataset. Other
hydrology datasets may be different
and Step 14 may not be required

Step 15: identify the immediate catchment area of

To identify the surface waterbody’s
immediate catchment as a proxy for
the immediate catchment area of
natural drainage features. These areas
may therefore be candidates for land
use/management and/or storm water

es (blue polylines)

atural drainage features
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Hydrological Cycle Model Stage 2: Catchment analysis
Geoprocessing instructions and example outputs

storage intervention to provide runoff
reduction ecosystem services

ArcGIS
geoprocessing
tool

BUFFER

Tool location:

Analysis Tools > Proximity >
BUFFER

Input feature
class/classes

Surface waterbodies within the study
area(s) [output from Step 14]

Output feature | Surface waterbodies clipped to the

class study area(s), buffered to identify their
potential immediate catchments

Output feature | \Waterbodies_Surface [buffer

class filename
structure

distance] BUFFER

Parameters

Buffer surface waterbody polylines to
75m

e Distance: linear unit 75m
e Dissolve type: ALL

N\

s,

Geoprocessing
notes

BUFFER: buffer the surface
waterbody polylines to the required
size using linear units. Where the
volume of input data and/ or
processing power allows, ensure that
all buffers are dissolved. This reduces
the number of output polygons from
the integration analysis.

Note: a 75m buffer is suggested here.
The buffer distance parameter is a key
area where sensitivity analysis can be
used to explore different outcomes
from the modelling

\
Surface waterbodies buffered to 75m (purple
polygons) — the buffered area is used as a
proxy for the immediate catchment area of
natural drainage features to identify
locations where land use/management
and/or storm water storage intervention may
be required to enhance runoff reduction
ecosystem services
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Hydrological Cycle Model Stage 3: Integration analysis
Geoprocessing instructions and example outputs

Purpose of Stage 3: to integrate outputs from Stages 1 and 2 by identifying where various classes of
slope fall within the immediate catchment areas of natural and artificial drainage features. These

areas of land are then delineated in a vector dataset and may become priorities for runoff reduction
ecosystem services

Supporting technical information in Chapter 4 — relevant sections

4.2,4.3,4.4and 4.7

Purpose of
step

Related section(s) in Chapter 7

Step 16: identify where areas of steeply sloped land fall within the immediate catchment area of
natural drainage features

To identify where areas of steeply
sloped land are located within the
immediate catchment of surface
waterbodies (as a proxy for natural
drainage features). These areas may be
a high priority for land
use/management and/or storm water
storage intervention to provide runoff
reduction ecosystem services

ArcGIS
geoprocessing
tool

INTERSECT
Tool location:
Analysis Tools > Overlay > Intersect

Input feature
class/classes

1. Buffered surface waterbody
polylines in the study area(s)
[output from Step 15]

2. Steep slope polygons in the study
area(s) [output from Step 8]

Output feature
class

Avreas of steeply sloped land
intersecting the immediate catchments
of surface waterbodies in the study
area(s)

Output feature
class filename
structure

STEEPSIopes_Water _INTERSECT

Parameters

N/A

Geoprocessing
notes

Purpose of
step

INTERSECT: intersect the buffered
surface waterbodies data with the
steeply sloped land data

Step 17: identify where areas of medium sloped land

of natural drainage features

To identify where areas of medium
sloped land are located within the
immediate catchment of surface
waterbodies (as a proxy for natural
drainage features). These areas may be
a medium priority for land
use/management and/or storm water
storage intervention to provide runoff
reduction ecosystem services

ArcGIS
geoprocessing
tool

INTERSECT
Tool location:
Analysis Tools > Overlay > Intersect

Input feature
class/classes

1. Buffered surface waterbody
polylines in the study area(s)

7.3.3

B o \
Steeply sloped areas of land within the
immediate catchment area of natural
drainage features (dark blue polygons). Blue
polylines are surface waterbodies, black
polygons are large areas of impermeable

ground

fall within the immediate catchment area
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Hydrological Cycle Model Stage 3: Integration analysis
Geoprocessing instructions and example outputs

[output from Step 15]

2. Medium slope polygons in the
study area(s) [output from Step
8]

Output feature
class

Areas of medium sloped land
intersecting the immediate catchments
of surface waterbodies in the study
area(s)

Output feature
class filename
structure

MEDIUMSIlopes_Water_INTERSEC
T

Parameters

N/A

Geoprocessing
notes

natural drai

INTERSECT: intersect the buffered
surface waterbodies data with the
medium sloped land data

nage features

B B S (o

s T

: T A
areas of land within the

i -
Medium sloped

immediate catchment area of natural
drainage features (light blue polygons). Blue
polylines are surface waterbodies, black
polygons are large areas of impermeable
ground

Step 18: identify where areas of gently sloped land fall within the immediate catchment area of

Purpose of
step

To identify where areas of gently
sloped land are located within the
immediate catchment of surface
waterbodies (as a proxy for natural
drainage features). These areas may be
a low priority for land
use/management and/or storm water
storage intervention to provide runoff
reduction ecosystem services

ArcGIS
geoprocessing
tool

INTERSECT
Tool location:
Analysis Tools > Overlay > Intersect

Input feature
class/classes

1. Buffered surface waterbody
polylines in the study area(s)
[output from Step 15]

2. Medium slope polygons in the
study area(s) [output from Step
8]

Output feature
class

Avreas of gently sloped land
intersecting the immediate catchments
of surface waterbodies in the study
area(s)

Output feature
class filename
structure

GENTLESIopes_Water INTERSECT

Parameters

N/A

Geoprocessing
notes

INTERSECT: intersect the buffered
surface waterbodies data with the
gently sloped land data

Step 19: identify where areas of steeply sloped land fall within the immediate catchment area of

artificial drainage features
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Hydrological Cycle Model Stage 3: Integration analysis

Geoprocessing instructions and example outputs

Purpose of
step

To identify where areas of steeply
sloped land are located within the
immediate catchment of large areas of
impermeable ground (as a proxy for
artificial drainage features). These
areas may be a high priority for land
use/management and/or storm water
storage intervention to provide runoff
reduction ecosystem services

ArcGIS
geoprocessing
tool

INTERSECT
Tool location:
Analysis Tools > Overlay > Intersect

Input feature
class/classes

1. Buffered large area of
impermeable ground polygons in
the study area(s) [output from
Step 12]

2. Steep slope polygons in the study
area(s) [output from Step 8]

Output feature | Areas of steeply sloped land

class intersecting the immediate catchments
of large areas of impermeable ground
in the study area(s)

Output feature | STEEPSlopes_Imper_INTERSECT

class filename
structure

Parameters

N/A

Geoprocessing
notes

INTERSECT: intersect the buffered
large areas of impermeable ground
data with the steeply sloped land data

. R A\
Steeply sloped areas of land within the
immediate catchment area of artificial
drainage features (red polygons). Blue
polylines are surface waterbodies, black
polygons are large areas of impermeable
ground

Step 20: identify where areas of medium sloped land fall within the immediate catchment area
of artificial drainage features

Purpose of
step

To identify where areas of medium
sloped land are located within the
immediate catchment of large areas of
impermeable ground (as a proxy for
artificial drainage features). These
areas may be a medium priority for
land use/management and/or storm
water storage intervention to provide
runoff reduction ecosystem services

ArcGIS
geoprocessing
tool

INTERSECT
Tool location:
Analysis Tools > Overlay > Intersect

Input feature
class/classes

1. Buffered large area of
impermeable ground polygons in
the study area(s) [output from
Step 12]

2. Medium slope polygons in the
study area(s) [output from Step
8]

Output feature
class

Avreas of steeply sloped land
intersecting the immediate catchments
of large areas of impermeable ground

z 3\“-*:1*:_/ — AN

Medium sloped areas of land within the
immediate catchment area of artificial
drainage features (orange polygons). Blue
polylines are surface waterbodies, black
polygons are large areas of impermeable
ground
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in the study area(s)

Output feature | MEDIUMSlopes_Imper_INTERSEC
class filename T

structure

Parameters N/A

Geoprocessing | INTERSECT: intersect the buffered
notes large areas of impermeable ground
data with the medium sloped land data
Step 21: identify where areas of gently sloped land fall within the immediate catchment area of
artificial drainage features

Purpose of To identify where areas of gently
step sloped land are located within the
immediate catchment of large areas of
impermeable ground (as a proxy for
artificial drainage features). These
areas may be a low priority for land
use/management and/or storm water
storage intervention to provide runoff
reduction ecosystem services

ArcGIS INTERSECT
?eolprocess'”g Tool location:
o0 Analysis Tools > Overlay > Intersect

Input feature | 3, Buffered large area of

class/classes impermeable ground polygons in
the study area(s) [output from
Step 12]

4. Steep slope polygons in the study
area(s) [output from Step 8]

Output feature | Areas of steeply sloped land

class intersecting the immediate catchments
of large areas of impermeable ground
in the study area(s)

Output feature | GENTLESIopes_Imper_INTERSECT
class filename - -

structure

Parameters N/A

Geoprocessing | INTERSECT: intersect the buffered
notes large areas of impermeable ground
data with the gently sloped land data
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Appendix 10: Habitat network
model step-by-step instructions
and example outputs

Specific technical guidance for undertaking all geoprocessing operations described
in this Appendix is available from the ArcGIS online help resources:

ArcGIS online help for buffer operations:
http://resources.arcgis.com/en/help/main/10.1/index.html#//000800000019000000
[accessed 23/11/13]

ArcGIS online help for clip operations:
http://resources.arcgis.com/en/help/main/10.1/index.htmI#//000800000004000000
[accessed 23/11/13]

ArcGIS online help — selecting and extracting data:
http://resources.arcgis.com/en/help/main/10.1/index.html#/Selecting and Extracting
data/018p00000005000000/ [accessed 23/11/13]

ArcGIS online help for intersect operations:
http://help.arcqis.com/en/arcgisdesktop/10.0/help/index.html#//00080000000p0000
00 [accessed 03/05/14]
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Habitat Network Model Stage 1: Analysis of ecological potential
Geoprocessing instructions and example outputs

Purpose of Stage 1: to identify areas of land within the study area where ecological potential to
support habitat establishment is high

Supporting technical information in Chapter 5 — relevant sections

5.1and 5.2

Purpose of
step

Related section(s) in Chapter 7

Step 1: Buffer study area polygon

[For study areas that aren’t defined by
natural features] to ensure that
opportunities for enhancing ecosystem
processes/intermediate services (i.e.
ecological connectivity ecosystem
services) at the peripheries of the
study area are captured in the analysis

ArcGIS
geoprocessing
tool

BUFFER

Tool location:

Analysis Tools > Proximity >
BUFFER

class filename
structure

Input feature | Study area polygons
class/classes

Olutput feature | Buffered study area polygons
class

Output feature | [study area name]_[buffer

distance] BUFFER

Parameters

Buffer study area polygons to increase
study area size by between 10 and
30%

Geoprocessing
notes

BUFFER: buffer the study area

polygons to the required size using

linear units. Do not dissolve buffers
Step 2:Clip the biodiversity opportunities, habitat patches and habitat networks datasets to the

7.4.1

geoprocessing
tool

study area

Purpose of Reduces the amount of data analysed
step in subsequent modelling steps

ArcGIS CLIP

Tool location:
Analysis Tools > Extract > CLIP

Input feature
class/classes

1. Buffered study area polygons
[output from Step 1]

2. Biodiversity opportunities
polygons for woodland, wetland
and grassland habitat

3. Existing habitat patch polygons
for woodland, wetland and
grassland habitat

4. Existing high dispersal habitat
network polygons for woodland,
wetland and grassland habitats

5. Existing low dispersal habitat
network polygons for woodland,
wetland and grassland habitats

sk (5 : 'ﬂ

Output feature
class

1. Biodiversity opportunities
polygons clipped to the study area
2. Existing habitat patch polygons

2 = %, .

Unimproved/ neutral grassland patches
(brown polygons), low/0.3km dispersal
habitat network (dark orange polygons) and
high/2km dispersal habitat network (pale
orange polygons) data clipped to the study
area
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Habitat Network Model Stage 1: Analysis of ecological potential
Geoprocessing instructions and example outputs

clipped to the study area

3. Existing high dispersal habitat
network polygons clipped to the
study area

4, Existing low dispersal habitat
network polygons clipped to the
study area

Output feature
class filename
structure

[habitat
type]_OPPOTUNITIES_[study area
name]_CLIP

[habitat type] HABITAT_[study area
name]_CLIP

[habitat type]_highDISPERSE_[study
area name]_CLIP

[habitat type] lowDISPERSE_[study
area name] CLIP

Parameters

N/A

Geoprocessing
notes

CLIP: clip the various habitats data
(input features) to the buffered study

To identify land where there is high

tool

step ecological potential to support the
three priority habitats considered in
the analysis

ArcGIS SELECT

geoprocessing | Too| |ocation:

Analysis Tools > Extract > Select

Input feature
class/classes

Biodiversity opportunities polygons
clipped to the study area [output from
Step 2]

Output feature
class

Biodiversity opportunity polygons
representing land with high ecological
potential to support habitat
establishment (i.e. an ecological
potential value of 3 or more)

Output feature
class filename
structure

[habitat
type] OPPORTUNITIES_HIGH_SEL
ECT

Parameters

Use SELECT tool and SQL query
builder to extract biodiversity
opportunities polygons with high
ecological potential only

Woodland SQL query:
[tbl] >=3

Wetland SQL query:
[twet] >=3

Grassland SQL query:
[tgrs] >= 3

Geoprocessing
notes

SELECT: extract high ecological
potential polygons from the three
biodiversity opportunities datasets

Land where ecological potential to support
grassland habitat establishment is high
(brown polygons)
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Habitat Network Model Stage 1: Analysis of ecological potential
Geoprocessing instructions and example outputs

(input feature) using the expressions
above

Habitat Network Model Stage 2: Identify prime sites
Geoprocessing instructions and example outputs

Purpose of Stage 2: to integrate the ecological potential data from Stage 1 with existing low and high
dispersal habitat networks data to identify prime sites for habitat creation/recreation

Supporting technical information in Chapter 5 — relevant sections

5.1and 5.2

Related section(s) in Chapter 7

7.4.2

Step 4: Intersect high ecological potential polygons with existing low and high dispersal habitat

networks data to identi rime sites for habitat enhancement works

Purpose of
step

To identify areas of land encompassed
by existing high and low dispersal
habitat networks that also have high
ecological potential to support the
three priority habitats considered in
the analysis. The land areas identified
may be prime candidates for various
habitat enhancement works including
improved management, restoration,
reducing the intensity of land use in
the matrix and creation/recreation of
areas of new semi-natural habitat.
Habitat enhancement delivered in
these areas has the potential to
increase the total area of habitat
networks and the area of habitat
patches within these networks

ArcGIS
geoprocessing
tool

INTERSECT
Tool location:
Analysis Tools > Overlay > Intersect

Input feature
class/classes

1. Biodiversity opportunity polygons
representing land with high
ecological potential to support
habitat establishment [outputs
from Step 3]

2. Existing high dispersal habitat
network polygons clipped to the
study area [outputs from Step 2]

3. Existing low dispersal habitat
network polygons clipped to the
study area [outputs from Step 2]

Output feature
class

Intersection of high ecological
potential habitat opportunity polygons
and existing high and low dispersal
habitat network polygons within the
study area

Output feature
class filename
structure

[habitat
type]_highOPPS_and_highDISPERSE
_[study area hame] _INTERSECT

vd

L e

: 2 e
Output (pale pink polygons) of intersecting
land with high ecological potential to
support grassland habitat establishment and
existing high dispersal grassland habitat
networks. The brown polygons show existing
grassland habitat patches
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Habitat Network Model Stage 2: Identify prime sites
Geoprocessing instructions and example outputs

[habitat
type]_highOPPS_and_lowDISPERSE
_[study area name] INTERSECT

Parameters N/A
Geoprocessing | INTERSECT: intersect the high
notes ecological potential habitat

opportunity polygons with existing
high and low dispersal habitat network
polygons

434




Land use planning in urban areas — towards an ecosystems approach
Peter M. Phillips, Department of Civil and Environmental Engineering, University of Strathclyde

Appendix 11: Evaluation of new
ecosystems approach based
urban land use planning
frameworks developed through
this research
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Key
Principle considered fully

Principle considered to a degree

Prineiple not considered
Consideration of principle unknown

Radar Ecosystem approach principle
Diagram
Code
EsA 1 Consider effects on adjacent ecosysienis

Evaluation comments: Designed to work at the catchment/ecosvstem scale.
Whole city planning would encompass multiple ecosystems. Buffering of study
areas captures effects on adjacent ecosy stems

EsA 2 Conserve ecosvsten swucture and function

Evaluation comments: Spatial models consider key ecosystem
processes/intermediate services (hy drological evcle and ecological connectivity).
New technical gnidance considers ecosv stem structure issues

EsA 3 Ecosysten management must respect environmenial limits

Evaluation comments; Consideration mainly implicit. Spatial models identify
locations where ecosystem service limits (see section 3.2.1) mayv be exceeded.

Remedial intervention identified through new technical guidance

EsA 4 Adopt the ecosystents approach ar appropriate spatial and temporal scale
Evaluation comments; Spatial models designed to work at the ecosystem scale
(especially urban water catchments). Temporal scale aligned to statutory LDP
process

EsA 5 Set long term objectives for ecosysiem managemernt

Evaluation comments: New approaches aligned to urban LDP process - i.e. 10
vear planning timeframe. Limited consideration of varving temporal scales and

lag effects

EsA 6 Ecosysten management must reco gnise that change is inevitable

Evaluation comments: Resilience thinking embedded with ecosystems
approach guiding principles and technical guidance. No specific consideration of
management for inevitable change

Evaluation of new urban land use planning approaches against the Convention on Biological Diversity (CBD) ecosystemns approach principles

Management of natural systemy

EsA 10
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Key

Principle considered fully

Principle considered to a degree

Principle not considered
Consideration of prineciple unknown

Radar Ecosystem approach principle
Diagram
Code
EsA 7 Understand and manage the ecosvstem in an economic context

Evaluation comments: Practical constraints and opportunities of uwrban land
management for ecosystem services considered to a degree. Use of gants,

incentives and regulation integrated with technical guidance

EsA 8 Ensure an appropriate balance between conservation and use of biodiversity
Evaluation comments: Conservation and sustainable use of biodiversity is
central to the whole approach. Spatial models and technical gnidance balance
conservation and use EsA 11
EsA 9 Objectives for ecosvsiem mandagement are a maner of socieial choice
Evaluation comments: New approach designed for integration with statutory
LDP process (see section §.3) including public and stakeholder consultation at
the MIR stage

EsA 10  |Ecosystem management should be decentralised to the lowest appropriate level
Evaluation comments: New approach designed to intervene at the
neighbourhood scale through multifunctional priority areas (see section §.3). No
specific mechanisms to support decentralised management however

EsA 11 |Consider all forms of relevant informarion including scientificlocal knowledge,
| prractice and innov ation

Evaluation comments: Implicit consideration only through integration with
statutory LDP process (see section 8.3) and associated consultations

EsA 12 |Dnolve all relevant sectors of society and scientific disciplines

Ecosystem services

EsA 10

Involving peopie

Evaluation comments; Asper EsAll

Evaluation of new urban land use planning approaches against the Convention on Biological Diversity (CBD) ecosystems approach principles
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Appendix 12: Example
application of the new
approaches in the Glasgow 2014
Multifunctional Greenspace
Project (MGP)
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